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Preface

◆ Purpose
This manual describes the functions and operation of RC2000.

RC2000 is a software product that provides functions for operating an OS console of a UNIX

server (PRIMEPOWER, GP7000F) via the network.

◆ Target readers
This manual is intended for UNIX server system administrators who operate and maintain the

system.

◆ Organization
This manual consists of three parts and Appendices A to D.

Chapter 1  Introduction

Describes the RC2000 features, operating modes, and configuration.

Chapter 2  Operating instructions

Describes the operating functions of RC2000.

Chapter 3  Functions

Describes the windows and menus provided by RC2000, and gives a detailed explanation of

RC2000 functions.

Appendix A  Command Reference

Describes the commands provided by RC2000.

Appendix B  Messages

Describes the messages displayed by RC2000 and the corrective actions to be taken for them.

Appendix C  Notes

Describes precautions, symptoms in the event of a failure and corrective actions.

Appendix D  Troubleshooting

Describes how to respond to a problem and how to collect data for troubleshooting. 

Glossary

Describes the terms used in RC2000.  Refer to this glossary whenever necessary.
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◆ Notation in this manual
The following notation is used in this manual:

● Bold indicates text that is entered by the user.

● Italic indicates variable parts in the command line.

● Italic indicates the variables that need to be replaced with specific character strings and

numeric values.  These variables are enclosed in angle brackets (< >).

● Reference locations are enclosed in quotation marks (").

● Menu names, button names, and icon names are enclosed in brackets ([ ])

● A number sign (#) indicates the prompt at which the system administrator enters a

command in command examples.  A dollar sign indicates the prompt at which someone

other than the system administrator can enter a command in command examples.

●  Indicates information that should be noted.

●  Indicates information provided for reference.

◆ Related document
Refer to the following manuals if necessary.

● PRIMECLUSTER Enterprise Edition Installation Guide

● PRIMECLUSTER HA Server Installation Guide

● Web-Based Admin View Operation Guide

● REMOTE CONSOLE CONNECTION UNIT USER’S MANUAL

● GP7000F System Management Console (SMC) User's Manual

● PRIMEPOWER System Management Console (SMC) User's Manual

● PRIMEPOWER100 User's Manual System Management Console model

● System Console Software (SCS) Release Notes

● INSTALLATION GUIDE System Console Software (SCS) 

● System Console Software (SCS) User's Guide

◆ Trademarks
Sun, Sun Microsystems, the Sun Logo, Solaris and all Solaris based marks and logos are

trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries,

and are used under license.

OpenBoot, Java, and Java-related product names are the trademarks or registered trademarks of

Sun Microsystems, Inc. in the United States and other countries.

Microsoft, Windows, WindowsNT, WindowsMe, Windows2000 and WindowsXP are the

trademarks or registered trademarks of Microsoft Corporation in the United States and other

countries.

Netscape, Netscape Navigator and Netscape Communications are trademark of Netscape

Communications Corporation in the United States and in other countries.
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Other product names are the trademarks or registered trademarks of their respective companies.

◆ Notice
The contents of this manual shall not be reproduced without the express written permission of

FUJITSU Limited.

The contents of this manual are subject to change without notice.

Manual code: J2X0-6100-02EN

First edition, 02, 2003

All Rights Reserved, Copyright (C) FUJITSU LIMITED 2003
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Chapter 1 Introduction

This chapter explains the RC2000 features and operating modes.
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1.1 The basics of RC2000

RC2000 is a remote console software product that manages the OS console of UNIX

servers(PRIMEPOWER, GP7000F) via the network, improving the manageability of system

operations.

Management by RC2000 enables the following software maintenance operations and supports

system operation management with the use of one remote console machine (machine on which

RC2000 runs):  display of data output to the OS console of each distributed UNIX server

(ordinary messages and panic messages), software installation and application of patches, and

rebooting and resetting.

The following describes the RC2000 features:

● Centralized management of the OS consoles of UNIX servers

RC2000 collectively manages the OS consoles of the UNIX servers that are distributed on

the network.  A UNIX server with a partition function can manage each partition

automatically when RC2000 is started.

If the partition configuration is changed after RC2000 is started, the update function can

be used to reflect the change without shutting down the OS console of a partition that is

not affected by the configuration change.

● OS console operation

RC2000 provides operability that is equivalent to that of the terminal emulator provided by

UNIX.  The environment setting function also provides an OS console operating

environment that is appropriate for the UNIX server environment.

● Read/write operations or read-only monitoring window for the OS console

RC2000 provides a console window that enables read/write operations for the input and

output of data.

On a UNIX server with the partition function, the console window that enables read/write

operations can be changed to the read-only monitoring console window.

The read-only monitoring console window suppresses input to the OS console by the user

and monitors data from the OS console.

● Simultaneous command entry from more than one OS console

The same command can be entered simultaneously on the OS consoles of distributed

UNIX servers managed by RC2000.

This feature is effective when the same operation needs to be performed for multiple UNIX

servers.

● Monitoring data output to the OS console

This feature monitors data that is output to the OS console and notifies a user when data

is sent to that user.

● A UNIX server with the partition function is managed on the system console.

RC2000 must be installed on the system console when the OS console of a UNIX server

with the partition function is managed.
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● For information on managing OS consoles other than these UNIX servers that are

managed on the system console, refer to “C.1 UNIX Servers Managed by RC2000,” in

Appendix C, “Notes.”
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1.2 RC2000 Operating Modes

1.2.1 Logical two-layer structure

RC2000 uses a two-layer structure architecture.

RC2000 uses such an architecture because it is used on a remote console machine (UNIX

workstation or PC) on the network to provide standardized operation or management.

RC2000's two roles are explained below.

Management server
The management server centrally manages OS console information of UNIX servers operated by

RC2000 and settings of the console window operating environment as RC2000 management

information.  It thereby provides integrated information and operability to all clients that work with

it.

Client
The functions for operating the OS console are provided as a (GUI) client application.  This

client application is normally called RC2000.

 RC2000 consists of the following windows:

1. Master control window

When RC2000 is started, the master control window opens.

UNIX servers for which the OS console is managed by RC2000 are listed as hosts on the

left side of the master control window.

Also, the master control window enables operators to specify and save OS console

operating environment settings.

2. Console window

The console window is used to operate the OS console of a UNIX server that is displayed

in the host browser in the master console window.

The console window can display data (ordinary messages and panic messages) to be

output to the OS console and input to the OS console (package installation and

reboot/reset).

1.2.2 Operating modes

1.2.2.1 Server/client operation
In this operating mode, the client (RC2000) can use Web-Based Admin View to link to the

management server so that RC2000 management information can be centrally managed on the

management server machine.  RC2000 thus provides all clients with integrated OS console

operability.

Depending on the operating pattern, RC2000 can be used on the Web-Based Admin View

management servers, the Web-Based Admin View client machines, and other client machines.
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The RC2000 operating patterns in this mode are explained below.

Operation on the management server machine(basic)
This mode is the operating mode when RC2000 is used on the management server.  One

machine is used as both management server and client.

RC2000 is started from Web-Based Admin View on the management server or client machine

and runs on the management server.

The following shows the configuration of this mode of operation.

Operation on the client machine (operation on machine other than the

management server)
In this operating mode, the management server and clients are on separate machines.  The

RC2000 management server function and client function are installed on a Web-Based Admin

View management server machine and a client machine (UNIX workstation or PC), respectively,

to implement this operating mode.

RC2000 is started from Web-Based Admin View that is displayed on the client machine and runs

on the client machine.

RC2000 acquires RC2000 management information from the management server function on the

management server machine via the network and saves it.  This information can be shared for

operations on the management server machine.

The following shows the configuration of this mode of operation.
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● For information on how to install RC2000 on a client machine, refer to the applicable

installation guides prepared for RC2000 component products.

● For security reason, assigning a public LAN as Web-based admin view communication

network is not generally recommended, and it should only be used if there is a network

availability restrictions.

For further information, refer to "Web-Based Admin View Operation Guide."

● The client machine must be on the same network as the management server machine.

● RC2000 must be installed on the primary and secondary management servers when the

Web-Based Admin View management server is duplicated.

● The system console is one of the management server machines.  For client machine

operations, do not use the system console as a client machine of the other server.

1.2.2.2 Local operation
In this operating mode, RC2000 does not work with Web-Based Admin View and a management

server; instead, it manages RC2000 management information on a client machine so that a client

(RC2000) can easily operate an OS console independently.

RC2000 can be used on a client machine (UNIX workstation or PC).

Use this operating mode only to manage OS consoles of UNIX servers not managed by the

system console.

The following shows the configuration of this mode of operation.

● This operation is implemented by installing RC2000 on a client machine.

For information on how to install RC2000 on a client machine, refer to the applicable

installation guides prepared for RC2000 component products.

● Do not use both server/client operation mode and local operation mode together on the

same machine.

● For information about management of OS consoles of UNIX servers not managed by the
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system console, refer to “C.1 UNIX Servers Managed by RC2000,” in Appendix C,

“Notes.”

● The system console is one of the management server machines.

Do not use local operation mode on the system console.
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1.3 Access to OS Consoles

Access authority
There are two levels of access authority to the OS consoles, as described below.

read/write operation
Data to be output to the OS console can be read, and data can be input to the OS

console.

read-only monitoring
Data to be output to the OS console can be read.   Data cannot be input to the OS

console.

For OS consoles of UNIX servers that have the partition function and are managed by the system

console, both read/write operation and read-only monitoring can be set.

The access authority is determined by the group to which a user logging in to Web-Based Admin

View belongs.

Each group has the access authority levels described below.

System administrator (root)
Has an authentication of read/write operations for all partitions.

Administrator of the server (cladmin) and Hardware Maintenance Engineer
(cemainte)

Has an authentication of read/write operations for all partitions.

Partition administrator (clmon)
Users belonging to both clmon and the management group of the partition to be handled

have access authority for read/write operations on all partitions.

Users belonging to clmon but not to the management group of the partition to be handled

have access authority for read-only monitoring on all partitions.

General user
Has an access authority to read-only monitoring for all partitions.

For the group, refer to "System Console Software User's Guide."

For OS consoles of UNIX servers having the partition function that are not managed by the

system console, only read/write operation can be set, and read-only monitoring cannot be set.

Access restrictions
UNIX servers with the partition function that are managed by the system console are restricted in

its access to the OS console.  The restrictions are affected by the access restrictions of the

group in which the user who logs in to Web-Based Admin View belongs.
Other UNIX servers have user-defined access restrictions.
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The following describes the access restrictions in individual operating modes:

Server/client operation
Operation is enabled only when a user logs in to Web-Based Admin View as the system

administrator (root).

Local operation
The following access restrictions apply to each type of client machine:

Solaris(TM) operating environment (hereafter referred to as Solaris OE):

Operation is enabled only when a user starts RC2000 as the system administrator (root).

Windows:

Operation is enabled when RC2000 is started.

● Fujitsu recommends that networks be used as follows:  Use a public LAN only when

the use range and users can be limited.  Otherwise, with a consideration for security,

separate the system from the public LAN.

● User access can not be restricted when using Windows. Consider other security

measures for operation in Windows.

● Restrictions on access by users also apply to the host addition/deletion function used

to manage UNIX servers other than those with the partition function that are

managed by the system console.





Chapter 2  Operating instructions

This chapter explains how to use the main RC2000 functions.
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2.1 Startup and exit RC2000
This section explains how to start and exit the master control window and console window that

construct RC2000.

2.1.1 Start a master control window

When starting up RC2000, the master control window is started.

For further information, refer to “3.1 Master Control Window.”

Take the following steps to start up the master control window.

● In any operation mode, do not start more than one RC2000 on the same client machine.

● To check whether the system is currently operating in server/client or local operation mode,

select the [Help] menu from the master control window, and then select [Environment].

Check “MODE” in the subsequently displayed environment window.

”SERVER-CLIENT” indicates the server/client operation mode.

”LOCAL” indicates the local operation mode.

Server/client operation
1. Start the Web browser.

2. Designate the following URL in the Web browser:

http://<server address>:<port>/Plugin.cgi

Designate the IP address or host name of the management server in <server address>.

In <port>, designate the http port number of Web-Based Admin View as defined on the

management server.  Users can check the port number by logging in to the management

server machine as the system administrator and executing the command shown below.

The default setting is 8081.

# /etc/opt/FJSVwvbs/etc/bin/wvSetport fjwv-h

3. On the login screen, enter a user name and password that have been registered on the

management server.

4. Select [RC2000] from the Web-Based Admin View menu.

The master control window is displayed.

For further information, refer to "3.1 Master control window."

● For a UNIX server with the partition function that is managed by the system console, OS

console access authority for each partition is determined by the group to which a user
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logging in to Web-Based Admin View belongs.

The access authority for the OS consoles of other UNIX servers is only for read/write

operations by the system administrator.

For the group and access authority, refer to "1.3 Access to OS Consoles.”

● RC2000 is started in the language used system-wide when the web browser was started.

It may not match the [language] menu of Web-Based Admin View.

For Look&Feel, RC2000 adopts Metal Look&Feel.  It may not match the [Look&Feel]

menu of Web-Based Admin View.

Note that the [Language] and [Look&Feel] menus may not be displayed for some Web-

Based Admin View versions.

Local operation

Solaris OE
1. Start the terminal emulator.

2. Execute the following command on the terminal emulator:

# /etc/opt/FJSVrcon/bin/rclocal &

The master control window opens.

For information on the rclocal command, refer to “A.1 rclocal.”

Windows

Running with a file name specified
1. Select “Start” and then “Run.”

2. Specify the following in the name field, and selecting [OK]:

<RC2000 installation folder>¥RC2000¥bin¥rclocal.exe

The master control window opens.

For information on the rclocal command, refer to “A.1 rclocal.”

2.1.2 Exit a master control window

Take the following steps to exit a master control window.

1. Select [Exit] from the [File] menu of the master control window.

Or, press mnemonic keys (press Alt. + F first, and then E).

2. If the console window is still open when closing the master control window, the

confirmation message dialog box, "You are already connected to the host.  Are you sure

you want to continue processing?" is displayed.

When selecting [OK], a master control window is closed.  When selecting [Cancel], it is

not closed.

If no console window is activated, no confirmation message dialog box is displayed.

For further information, refer to "3.1 Master control window."

● In server/client operation mode, exiting the Web browser or closing the Web-Based Admin

View window does not affect RC2000 operation.
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2.1.3 Start a console window

Take the following steps to start a console window.

For further information, refer to "3.2 Console window."

Start from a menu
1. Select a UNIX server from a host browser of the master control window.  More than one

UNIX server can be selected.

2. Select [Connect] from the [Execute] menu.

Or, press mnemonic keys (press Alt. + E first, and then C).

The console window of the UNIX server selected in the host browser is displayed.

For the execution menu, refer to "3.1.2.7 [Execute]-Connect" in "3.1.2 Menus of the master

control window."

Start by double-clicking
1. Double-click the UNIX server in the host browser.

The console window of the UNIX server double-clicked is displayed.

Start by an Enter key
1. Select a UNIX server in the host browser.  More than one UNIX server can be selected.

2. Press the Enter key.

The console window of the UNIX server selected in host browser is displayed.

● Only one console window for read/write operations can be activated for each UNIX

server.

● A maximum of 14 console windows from which read-only monitoring can be performed

can be opened for one partition on a UNIX server that has the partition function.

2.1.4 Exit a console window

Take the following steps to exit the console window.

For further information, refer to "3.2 Console window."

Exit from a menu of the master control window
1. Select a UNIX server in the host browser.  More than one UNIX server can be selected.

2. Select [Disconnect] from the [Execute] menu.

Or, press mnemonic keys (press Alt. + E first, and then D).

The console window of the UNIX server selected in the host browser is terminated.

For the execution menu, refer to "3.1.2.8 [Execute]-Disconnect" in "3.1.2 Menu of the master

control window."

Exit from a title bar.
1. Click the button for closing on the title bar.
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The console window whose exit icon was clicked is terminated.

Exit from a title menu
1. Select [Exit] from the [File] menu.

Or, press mnemonic keys (press Alt. + F first, and then E).

The console window executed in the menu is terminated.

For further information, refer to "3.2.2.1 [File]-Exit" in "3.2.2 Menus of the console window."

Exit by closing the master control window
1. If the console window is still open when closing the master control window, the

confirmation message dialog box, “You are already connected to the host.  Are you sure

you want to continue processing?” is displayed.

2. When selecting [OK], the master control window and all other console windows are

terminated.

When selecting [Cancel], neither is terminated.

For further information, refer to "2.1.2 Exit a master control window."
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2.2 Input or output from the operating system

console
While a console is open, data (ordinary messages and panic messages) output to the OS

console can be displayed in the console window, and data can be input to the OS console

(package installation and reboot/reset).

For the startup and exit procedure, refer to "2.1.3 Start a console window" and "2.1.4 Exit a

console window."

● The input into the OS console is not available in the console window of read-only

monitoring type.



2.3 Addition of host

17

2.3 Addition of host
The UNIX server can be added to the host browser.

Use this function to manage the UNIX servers which are not the ones with the partition function

managed by the system console.

Take the following steps to add the host:

1. Select [Add Host...] from the [File] menu of the master control.

Or, press mnemonic keys (press Alt. + F first, and then A).

The host addition dialog box is displayed.

2. Input information of the UNIX server to be added to the host browser in each item of the

dialog box.

3. Select the [OK] button or [Add] button. The UNIX server is added to the "Host" group on

the host browser.

― When [OK] is selected, the host addition dialog box is closed.

― When [Add] is selected, the addition dialog box is not closed.

When [Cancel] is selected, the processing is stopped, and the host addition dialog box

is closed.

For further information, refer to "3.3 Adding hosts."

● Because of access restrictions, only a specific user can add a host.  This specific user

means a user who can operate an OS console of a UNIX server that is not one of the

UNIX servers with the partition function that are managed by the system console.  For

more information, refer to “Access restrictions” in “1.3 Access to OS Consoles.”

● RC2000 centrally manages OS console information of UNIX servers to provide integrated

console information to every client.  During operation with multiple clients, remember that

OS console information of UNIX servers is updated when this function is executed on

another client.  In this event, select [Refresh] from the [File] menu in the master control

window to reflect the latest OS console information of UNIX servers in the host browser,

and then add a host.

● There are some notes about additional UNIX servers.  For details, refer to “C.1 UNIX

Servers Managed by RC2000,” in Appendix C, “Notes.”

● Added hosts belong to the "Host" group.  If the "Host" group does not exist, it is added.
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2.4 Deletion of host
A UNIX server that has been added using the host addition function can be deleted from the host

browser.

  

Take the following steps to delete the host:

1. Select a host of the "Host" group in the UNIX server.  More than one UNIX server can be

selected.

2. Select [Delete Host] from the [File] menu of the master control window.

Or, press mnemonic keys (press Alt. + F first, and then D).

The confirmation message dialog box “Are you sure you want to continue host deletion?”

is displayed.

3. When selecting [OK], the selected host is deleted from the host browser.

When [Cancel] is selected, it is not deleted.

● Because of access restrictions, only a specific user can delete a host.  This specific user

means a user who can operate an OS console of a UNIX server that is not one of the

UNIX servers with the partition function that are managed by the system console.  For

more information, refer to “Access restrictions” in “1.3 Access to OS Consoles.”

● RC2000 centrally manages OS console information of UNIX servers to provide integrated

console information to every client.  During operation with multiple clients, remember that

OS console information of UNIX servers is updated when this function is executed on

another client.  In this event, select [Refresh] from the [File] menu in the master control

window to reflect the latest OS console information of UNIX servers in the host browser,

and then delete a host.

● The host deletion is valid only to the UNIX server of the “Host.”  This function cannot be

used for a UNIX server with the partition function.

● If all hosts are deleted from the "Host" group, the "Host" group is also deleted.
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2.5 Monitoring the console window
When the data is output, the console window is notified of this.

Take the following steps to validate the console window monitoring:

1. Select a UNIX server in the host browser.  More than one UNIX server can be selected.

2. Select [Set Environment...] from the [Settings] menu of the master control window.

Or, press mnemonic keys (press Alt. + S first, and then S).

The environment setting dialog box is displayed.

3. Check by clicking the [Do Data Arrival] checkbox of the [Data Arrival] menu item.

Or, press mnemonic keys (press Alt. + T), or move the focus by using the Tab key and

press the space bar.

4. Select [Reflect] or [Save&Reflect] button in the environment setting dialog box.

“DATA” is displayed in the icon of the host browser of the selected UNIX servers.

When the data is output to a console window, the icon of a host browser turns red.

When canceling the monitoring function, select the UNIX server under monitoring, and uncheck

the checkbox with the same procedure.  When it is completed, “DATA” characters are deleted

from the icon of the host browser.

For data arrival, refer to "3.5.2.7 Data Arrival" in "3.5.2 Items in the environment settings dialog

box."

For [Reflect] button and [Save&Reflect] button, refer to "Buttons" in "3.5.1 Screen layout of the

environment settings dialog box."

● If the console window is not active, monitoring starts when the console window is

activated.

If the console window is already active, monitoring starts when the procedure is

completed.

● In the following cases, the red icon in the state of notifying the data arrival is changed to

the icon indicating that no data has arrived:

― The UNIX server is double-clicked in the host browser.

― An Enter key is pressed after selecting the UNIX server from the host browser.

― [Connect] is selected from the [Execute] menu after selecting the UNIX server from

the host browser.

― The console window is being closed.

― Monitoring of the console window is being canceled in the environment setting

dialog box.
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2.6 Setting and saving the environment of the

console window
The operation environment of the console window can be set and saved.

Take the following steps to set up and save:

1. Select a UNIX server in the host browser.  More than one UNIX server can be selected.

2. Select [Set Environment...] from the [Settings] menu of the master control window.

Or, press mnemonic keys (press Alt. + S first, and then S).

The environment-setting dialog box is displayed.

3. Set up the operating environment of the console window in each item of the environment

setting dialog box.

4. Select the [Reflect] button or [Save&Reflect] button.

― When selecting the [Reflect] button, the setup is validated in the console window.

In this case, the setup will not be validated when RC2000 is activated next time.

― When selecting the [Save&Reflect] button, the confirmation message dialog box

“Are you sure you want to continue save processing?” is displayed.

If [OK] is selected, the setup is validated and saved in the console window.  These

settings will be effective when RC2000 is activated next time.

If [Cancel] is selected, the processing is stopped, and no action is taken.

For further information, refer to "3.5 Environment setting/saving."

● If the console window is not open, settings are reflected when a console window is

opened.

If the console window is already open, settings are reflected immediately.

● In server/client operation mode, environment settings are saved as RC2000 management

information on the management server for each user.  This also applies to operation on

client machines.  Therefore, the environment settings are used for all relevant operations

of RC2000 started by the same user.

In local operation mode, the environment settings are saved as RC2000 management

information on the client machines for each user.
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2.7 Simultaneous command input into multiple

console windows
The optional command can be concurrently input into more than one OS console.

Take the following steps to input commands concurrently:

1. Select a UNIX server in the host browser.  More than one UNIX server can be selected.

2. Select [Common Input...] from the [Execute] menu of the master control window.

Or, press mnemonic keys (press Alt. + E first, and then I).

The common command input dialog box is displayed.

3. Enter the command string to be sent in the [Command input area] field of the common

command input dialog box window.

The input string is sent, among selected UNIX servers, to any corresponding open

console window in which the read/write operation can be performed.

4. Press the [Enter] key.

The “Enter” is reflected on the console window.  The string is cleared from the command

input area field and is instead displayed in the [Command history display area] field.

For further information, refer to "3.7 Common command input."

● Selected UNIX servers in the host browser can be changed while the common command

input dialog box window is open.  Objects to be sent are UNIX servers selected at the

time of data entry in the [Command input area] field.

● The execution status and result of an input command depend on the user login

environment that exists on the UNIX server.
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2.8 Reflecting configuration changes
A change to the configuration of the server or the authority for a partition can be reflected in the

host browser while RC2000 is running.  This applies to UNIX servers with the partition function

that are managed by the system console.

Take the following steps to validate those modifications in the host browser:

1. Select [Update] from the [File] menu of the master control window.

Or, press mnemonic keys (press Alt. + F first, and then U).

The confirmation message dialog box “Are you sure you want to continue update

processing?” is displayed.

2. When selecting [OK], the host browser is updated.

When selecting [Cancel], it is not updated.

For the file menu, refer to "3.1.2.4 [File]-Update" in "3.1.2 Menus of the master control window."

● Be sure to execute when the configuration of the server is modified.

● When this function is executed, the name of the UNIX server added by the host addition

function is reflected with the latest information in the host browser.

● In the following cases, connection to any open console window is interrupted:

― When the corresponding partition is deleted.

― When the access authority to the partition is modified from read/write operation to

read-only monitoring.

― When the main power switch (circuit breaker) of the server containing the

corresponding partition is OFF.

― When the corresponding UNIX server is deleted or changed by another client.

● While the console window is open, if the string to be displayed in the host browser is

changed then the title of the console window is changed.

● If the main power switch (circuit breaker) of the server is OFF, the configuration of the

server is not displayed in the host browser.
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2.9 Switching to read-only monitoring of the

console window
The console window access authority can be changed from read/write operation to read-only

monitoring for UNIX servers with the partition function that are managed by the system console.

The read/write operable console window can only one be activated for each partition.  If no

read/write operation is required, the modification to read-only monitoring is recommended.

Take the following steps to change to the read-only monitoring:

1. Select the partition that is capable of read-write operation from the host browser.  More

than one partition cannot be selected.

Also, the partition where the console window is activated cannot be selected.

2. Select [Change Mode] from the [Execute] menu of the master control window.

Or, press mnemonic keys (press Alt. + E first, and then M).

The authentication of the selected partition is changed to the read-only monitoring from

read/write operations.  Also, the display of access authority in the host browser is

changed to [R ] from [RW].

If restoring the read-write operations, take the same steps after selecting the partition that is

modified to read-only monitoring.

For the execution menu, refer to "3.1.2.10 [Execute]-Change Mode" in "3.1.2 Menus of the

master control window."

● While a console window is open, the authority level cannot be changed to read-only

monitoring and it cannot be restored to read/write operation.

● The access authority for the UNIX server that has been added by using the host addition

function is for read/write operation only.  Access authority cannot be changed.

● In the host browser, [RW] is displayed for the partition that is capable of read/write

operation, and [R ] for the partition that is capable of read-only monitoring.

● The access authority for each partition is determined by the group to which a user logging

in to Web-Based Admin View belongs.

For the group and access authority, refer to "1.3 Access to OS Consoles."
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2.10 Copy and paste on the console window
Copy and paste is available on the console window.

Copying
Take the following steps to copy:

Copy by using a menu
1. Select the range for copying on the console window using the mouse.

2. Select [Copy] from the [Edit] menu in the console window from which the range for

copying is selected.

Or, press mnemonic keys (press Alt. + D first, and then C).

The area of the selected range (the highlighted area) is copied.

For the edit menu, refer to "3.2.2.7 [Edit]-Copy" in "3.2.2 Menus of the console window."

Copy by using a mouse
1. Select the range using mouse button 1 or 3 on the console window.

The area of the selected range (the highlighted area) is copied.

For the mouse buttons, refer to "3.5.2.8 Mouse Type."

Pasting
Take the following steps to paste:

Paste by using a menu
1. Select [Paste] from the [Edit] menu in the console window to which to paste.

Or, press mnemonic keys (press Alt. + D first, and then P).

Paste the copied contents at the cursor position.

For the edit menu, refer to "3.2.2.8 [Edit]-Paste" in "3.2.2 Menus of the console window."

Paste by using a mouse
1. Click the mouse button 2.

Paste the copied contents at the cursor position.

For the mouse buttons, refer to "3.5.2.8 Mouse Type."

● It might not be compatible with other applications for copy and paste in Japanese.  For

further information, refer to "C.5 Copy and paste" in Appendix C, "Notes.”
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3.1 Master control window
The master control window is displayed when starting RC2000.

This section describes the master control window.

3.1.1 Screen layout of the master control window

The screen layout is shown below.

Master control window

[Window title]
The window title "RC2000" is displayed on the upper part of the master control window.

[Menu]
Menus that can be used in the master control window are displayed on the bottom of the

window title of the master control window.

When selecting the menu, the pull-down menu is displayed.  The menu configuration is

as listed below.

For each menu, refer to "3.1.2 Menus of the master control window."

The partition selected in the host browser becomes subject to execution of the menu item.

Menu Item
Add Host...
Change Host...
Delete Host
Update...
Redraw HostBrowser

File

Exit
Connect
Disconnect
Force Connect
Change Mode

Execute

Common Input...
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Menu Item
Set Environment...Settings
Set Starting...
CascadeWindow
Tile

Help Environment

[Host browser viewport]
Left part of the master control window.  UNIX servers managed by RC2000 are listed.

[Console window viewport]
Right part of the master control window.  The console window for the UNIX server

selected in the host browser is displayed.

[Status area]
When the RC2000 is started, the host browser updated, or the environment saved, a

message indicating the status of the RC2000 operation is displayed at the bottom of the

master control window.

3.1.2 Menus of the master control window

This section describes the menus in the master control window.

3.1.2.1 [File]-Add Host
Display the host addition dialog box.

The host addition dialog box enables the user to set up the UNIX server and add it to the host

browser.

Any added host belongs to the " Host " group.  The " Host " group is added if it does not already

exist.

For the host addition dialog box, refer to "3.3 Adding hosts."

● Because of access restrictions, this menu cannot be selected by users who have no

permission to operate OS consoles of UNIX servers that are not the ones with the partition

function that are managed by the system console.  For details, refer to “Access

restrictions” in “1.3 Access to OS Consoles.”

● There are some notes about additional UNIX servers.  For details, refer to “C.1 UNIX

Servers Managed by RC2000,” in Appendix C, "Notes.”

3.1.2.2 [File]-Change Host
Display the host change dialog box.

In this dialog box, the string to be displayed of an added UNIX Server of the "Host" group

selected in the host browser can be modified.

UNIX servers for the "Host" group has been added using the host addition function.

More than one UNIX Server cannot be selected.

For the host change dialog box, refer to "3.4 Changing host."
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● This menu cannot be used for UNIX servers with the partition function that are managed

by the system console.

● This is not available while activating the console window.

● Because of access restrictions, this menu cannot be selected by users who have no

permission to operate OS consoles of UNIX servers that are not the ones with the partition

function that are managed by the system console.  For details, refer to “Access

restrictions” in “1.3 Access to OS Consoles.”

3.1.2.3 [File]-Delete Host
Deletes hosts of the "Host" group that have been selected from the host browser.

UNIX servers for the "Host" group has been added using the host addition function.

More than one UNIX server can be selected.

Before deleting a UNIX server, the confirmation message dialog box “Are you sure you want to

continue host deletion?” is displayed.  When selecting [OK] the UNIX server is deleted.

● This menu cannot be used for UNIX servers with the partition function that are managed

by the system console.

● This is not available while activating the console window.

● Because of access restrictions, this menu cannot be selected by users who have no

permission to operate OS consoles of UNIX servers that are not the ones with the partition

function that are managed by the system console.  For details, refer to “Access

restrictions” in “1.3 Access to OS Consoles.”

● If all hosts are deleted from the "Host" group, the "Host" group is also deleted.

3.1.2.4 [File]-Update
Updates the host browser display when the server configuration or partition access authority is

changed on any one of the UNIX servers with the partition function that are managed by the

system console.

The confirmation message dialog box “Are you sure you want to continue update processing?” is

displayed.  Selecting the [OK] to update the host browser.

● Be sure to execute this menu item when the configuration of the server or the access

authority for partitions is modified.

● When this function is executed, the name of the UNIX server added by the host addition

function is reflected with the latest information in the host browser.

● In the following cases, connection to any activate console window is interrupted:

― When the corresponding partition is deleted.

― When the access authority to the partition is modified from read/write operation to
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read-only monitoring.

― When the main power switch (circuit breaker) of the server containing the

corresponding partition is OFF.

― When the corresponding UNIX server is deleted or changed by another client.

● While the console window is activated, if the string to be displayed in the host browser is

changed then the title of the console window is changed.

● If the main power switch (circuit breaker) of the server is OFF, the configuration of the

server is not displayed in the host browser.

3.1.2.5 [File]-Redraw HostBrowser
Redraws the host browser.

3.1.2.6 [File]-Exit
Exits RC2000.

If the console window is still open when closing the master control window, the confirmation

message dialog box, "You are already connected to the host.  Are you sure you want to continue

processing?" is displayed.

When selecting [OK], a master control window and all activating console windows are closed.

3.1.2.7 [Execute]-Connect
Starts the console window for the UNIX server selected in the host browser.  More than one

UNIX server can be selected.

If connection is already activated, the console window comes to the front.

If it is red icon in the state of notifying the data arrival, the icon changes to indicate that no data

has arrived.

● When selecting the group in the host browser, it is not available.

3.1.2.8 [Execute]-Disconnect
Exit the console window for the UNIX server selected in the host browser.  More than one UNIX

server can be selected.

For the UNIX server where its console window is not activated, it remains the same.

● When selecting the group in the host browser, it is not available.

3.1.2.9 [Execute]-Force Connect
If a console window corresponding to a partition selected from the host browser is already active

on UNIX servers with the partition function that are managed by the system console, the

connection to the console window is forcibly interrupted, and then a new console window

becomes active.

Before making forcible connection, the confirmation message dialog box "Are you sure you want

to continue forced connection?  The console currently connected will be disconnected." is
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displayed. Selecting the [OK] executes the forced connection.

More than one partition cannot be selected.

Also, it is available only to the read-write operable partition.

● Since connection to activate console windows are forcibly interrupted, use this menu item

only in case of an emergency.

● When selecting the group in the host browser, it is not available.

● This menu cannot be used for a UNIX server that has been added using the host addition

function.

3.1.2.10 [Execute]-Change Mode
Changes the access authority for a partition that is selected in the host browser from read/write

operation to read-only monitoring.  This applies to UNIX servers with the partition function that

are managed by the system console.

More than one partition cannot be selected.

This menu is available only for partitions whose console window has not been activated and in

which read/write operations can be performed.

When the modification to the read-only monitoring is done by using this menu, it is possible to

restore the read-write operation.

● This is not available while activating the console window.

● When selecting the group in the host browser, it is not available.

● This menu cannot be used for UNIX servers that has been added using the host addition

function.

3.1.2.11 [Execute]-Common Input
Displays the common command input dialog box.

The command specified by a user can be sent to the selected UNIX servers.

The command is sent, among the UNIX servers selected from the host browser at the time of key

entry, to the UNIX servers whose console windows are activated and for which read/write

operations are enabled.

For the common command input dialog box, refer to "3.7 Common command input."

3.1.2.12 [Settings]-Set Environment
Displays the environment setting dialog box.

The operating environment of the console for the UNIX server selected in the host browser can

be set up.

More than one UNIX server can be selected.

For the environment setting dialog box, refer to "3.5 Environment setting/saving."
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● When selecting the group in the host browser, it is not available.

3.1.2.13 [Settings]- Set Starting
Displays the startup setting dialog box.

In the startup setting dialog box, setting for RC2000 startup can be made.

For the startup setting dialog box, refer to "3.6 Startup setting."

3.1.2.14 [Window]-Cascade
Displays all console windows in the viewport by cascade.

However, the console window minimized to icon is not applicable.

Resize all console windows as required.

● Be sure to execute the following command after login to the OS console, and set up the

values of output COLUMNS and LINES in the environment variable COLUMNS and

environment variable LINES.

      $ /usr/openwin/bin/resize

3.1.2.15 [Window]-Tile
Displays all console windows in the viewport side by side.

However, the console window minimized to icon is not applicable.

Resize all console windows as required according to the viewport.

● Be sure to execute the following command after login to the OS console, and set up the

values of output COLUMNS and LINES in the environment variable COLUMNS and

environment variable LINES.

      $ /usr/openwin/bin/resize

3.1.2.16 [Help]-Environment
Displays the execution environment of RC2000.

To check whether the system is currently operating in server/client or local operation mode, select

"MODE" in the window displayed when this menu item is selected.  

"SERVER-CLIENT" indicates the server/client operation mode.

"LOCAL" indicates the local operation mode.
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3.1.3 Host browser

Host browser is displayed on the left side of the master control window.  It contains a listing of

UNIX server configurations.

This section describes the screen layout of the host browser.

A list of UNIX servers with the partition function that are managed by the system console and a

list of UNIX servers added using the host addition function are shown in tree view.

For example, in server/client operation mode, UNIX servers with the partition function that are

managed by the system console and UNIX servers without the partition function that have been

added using the host addition function are displayed as follows:

Top group (HostBrowser)
It is constantly displayed in the top.  The UNIX server configurations follow after the top

group.

The display name is HostBrowser.  The icon indicating the top group is as follows:

― Clicking the top group

When clicking the top group, it goes into the state of selection.

By pressing the Enter key while the top group is selected, the view of groups under

the top group can be expanded or collapsed.

― Double-clicking the top group

Double clicking the top group expands or collapses the view of groups under the top

group.

Group
The icon indicating a group is as follows:

"SystemConsole-<system console's host name>" is displayed as the group name for the

group of UNIX servers with the partition function that are managed by the system console.

"Host" is displayed as the group name for the group of UNIX servers that have been

added using the host addition function.
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― Clicking a group

When clicking the top group, it goes into the state of selection.

By pressing the Enter key while a group is selected, the view of hosts in the group

can be expanded or collapsed.

― Double-clicking a group

Double-clicking a group, the view of hosts in the double-clicked group expanded or

collapsed.

Container
A container is displayed on a group.

The icon indicating a container is as follows:

― Clicking a container

By clicking a container, the view of hosts in the clicked container can be expanded

or collapsed.

Host
A UNIX server with the partition function that is managed by the system console is

displayed in the following format:  indicates an icon.

 [Authority]segment number - server name - partition ID(host name)
 

―  (Icon):  The icon type indicates the presence/absence of the data arrival setting,
the data arrival status, and the open/closed status of the console window.  The

following icon types are supported:

 

‐    Unconnected - No data arrival setting

‐    Unconnected - Data arrival setting

‐    Connecting

‐    Connected - No data arrival setting

‐    Connected - Data arrival setting with no data arrival notification

‐    Connected - Data arrival setting with data arrival notification

― Authority:  The access authority for the OS console is displayed.

― Segment number:  The segment number is displayed.

― Server name:  The name of the server is displayed.

― Partition ID:  The partition number of the server is displayed.

― Host name:  The host name of a partition is displayed.

 

A UNIX server that has been added using the host addition function is displayed in the

following format:  indicates the icon.
  

   Registered name
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―  (Icon):  The icon type indicates the presence/absence of the data arrival setting,
the data arrival status, and the open/closed status of the console window.  For the

icon types, refer to the above.

― Registered name:  The string set up in [Registered Name] in the host addition

dialog box is displayed.

― Clicking a host

When clicking a host, it goes into the state of selection.

By pressing the Enter key while a host is selected, a console window is activated.

If already connected, the console window comes to the front.  If it is red icon in the

state of notifying the data arrival, the icon changes to indicate that no data has

arrived.

― Double-clicking a host

By double-clicking a host, a console window corresponding to the double-clicked

host is activated.

If already connected, the console window comes to the front.  If it is red icon in the

state of notifying the data arrival, the icon changes to indicate that no data has

arrived.

● Because of access restrictions, UNIX servers that belong to the “Host” group cannot be

operated by users who have no permission to operate OS consoles of UNIX servers that

are not the ones with the partition function that are managed by the system console.  For

details, refer to “Access restrictions” in “1.3 Access to OS Consoles.”
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3.2 Console window
The console window is displayed in the viewport for the console windows of the master control

window (on the right side of the host browser).

If a UNIX server is connected successfully, the console window starts to operate as the UNIX

server’s OS console.

This section describes the console window.

● The window size on startup is fixed to 80 (horizontal) X 24 (vertical).

● The console window can be resized by dragging the window frame.

In this case, be sure to execute the following command after login to the OS console, and

set up the values of output COLUMNS and LINES in the environment variable COLUMNS

and environment variable LINES.

  

      $ /usr/openwin/bin/resize

3.2.1 Screen layout of the console window
The screen layout is shown below.

Console window

[Window title]
The window title "(< [Authority] >) <Host name>:<group name>" is displayed on the upper

part of the console window.

The <host name> indicates a character string that is displayed in the host browser.

<group name> is the name of the group to which the selected UNIX server belongs.

For a UNIX server with the partition function ,<Authority> is displayed at the beginning of

the window title.  <Authority > is [RW] when read/write operations are possible and [R ]

when read-only monitoring is possible.
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No authority is displayed in the console window for a UNIX server that has been added

using the host addition function.

[Menu]
The menu available in the console window is displayed on the bottom of the window title of

the console window.

When selecting the menu, the pull-down menu is displayed.  The menu configuration is

as follows:

For each menu, refer to "3.2.2 Menus of the console window."
Menu Item

File Exit
Redraw Window
Reset Terminal
Clear Screen
Clear All Screen

Execute

Send Break
CopyEdit
Paste

[Data input/output area]
This indicates the area where the data for the console is input or output to the UNIX server.

The data from the connected UNIX server is displayed.

[Scroll bar]
The scroll bar is displayed on the right of a console window.

The scroll buffer can be checked by scrolling the screen.  It indicates the scroll buffer

used to save invisible lines behind the top of the screen.

The size of buffer is 5120 lines as default.  The number of lines in the scroll buffer can be

changed in the environment setting.

For the environment setting, refer to "3.5.2.3 Lines To Be Scrolled" in "3.5 Environment

setting/saving."

3.2.2 Menus of the console window

This section describes the menus of the console window.

3.2.2.1 [File]-Exit
Exits the console window.

3.2.2.2 [Execute]-Redraw Window
Redraws the data input/output area of the console window.

3.2.2.3 [Execute]-Reset Terminal
Resets the scroll area of the console window.

3.2.2.4 [Execute]-Clear Screen
Resets the scroll area of the console window and terminal attributes and clears the data

input/output area.
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3.2.2.5 [Execute]-Clear All Screen
Clears the screen and the scroll buffer.

The scroll buffer is used to save invisible lines behind the top of the screen.

3.2.2.6 [Execute]-Send Break
Sends Telnet-Break to the connected UNIX server in the console window.  When Telnet-Break is

sent, the UNIX server changes to the Open Boot mode.

The confirmation message dialog box "Are you sure you want to move to the OpenBoot

environment?" is displayed.  Selecting the [OK] sends the Break signal.

● This menu is valid only in the console window where read/write operations are enabled.

● The system might not be put in OpenBoot mode, depending on the UNIX server model

number and hardware settings. For more information, refer to “Symptom 17: The UNIX

server is not put in OpenBoot mode even though a Break signal is sent” in Appendix D,

“Troubleshooting.”

3.2.2.7 [Edit]-Copy
Copies the range selected by the mouse.

Mouse button operation can also perform an equivalent function.

For mouse button operations, refer to "3.5.2.8 Mouse Type."

3.2.2.8 [Edit]-Paste
Pastes the copied content at the cursor position.

Mouse button operation can also perform an equivalent function.

For mouse button operations, refer to "3.5.2.8 Mouse Type."

● This menu is valid only in the console window where read/write operations are enabled.
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3.3 Adding hosts
The host addition dialog box is displayed by selecting [Add Host...] of the [File] menu in the

master control window.

In the host addition dialog box, information about the UNIX server can be specified for addition to

the host browser.

Any added host belongs to the "Host" group.  If the "Host" group does not exist, "Host" group is

added.

This section describes how to add hosts.

● Because of access restrictions, the [Add Host ...] menu cannot be selected by users who

have no permission to operate OS consoles of UNIX servers that are not UNIX servers

with the partition function that are managed by the system console.  For details, refer to

“Access restrictions” in “1.3 Access to OS Consoles.”

● In server/client operation mode, environment settings are saved as RC2000 management

information on the management server.  The added UNIX server is thus reflected in

every operation.

In local operation mode, the environment settings are saved as RC2000 management

information on the client machines.

● There are some notes about additional UNIX servers.  For details, refer to “C.1 UNIX

Servers Managed by RC2000” in Appendix C, "Notes.”

3.3.1 Screen layout of the host addition dialog box

In the host addition dialog box, information required to add the specified UNIX server to the

"Host" group in the host browser can be specified.

The screen layout is shown below.

Host addition dialog box

[Dialog box title]
The dialog box title " Add Host" is displayed on the upper part of the host addition dialog

box.
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[Setting items]
Each item to be set in the host addition dialog box is displayed.  For each item, refer to

"3.3.2 Items in the host addition dialog box."
Item

Connecting Host
Registered Name
Port

[Buttons]
The host addition dialog box has the following buttons:

 

[OK]
Adds the specified UNIX server to the host browser before closing the host addition

dialog box.

The specified UNIX server information is saved as RC2000 management

information on the management server machine in server/client operation mode or

on a client machine in local operation mode.

[Cancel]
Closes the host addition dialog box.  Added settings do not become valid.

 

[Add]
Adds the specified UNIX server to the host browser.  [Registered Name] and [Port]

are set as the state at the time of the host addition dialog box was activated.  The

[Connecting Host] is not cleared.

The specified UNIX server information is saved as RC2000 management

information on the management server machine in server/client operation mode or

on a client machine in local operation mode.

The host addition dialog box is not closed.

3.3.2 Items in the host addition dialog box

This section describes each item in the host addition dialog box.

3.3.2.1 Connecting Host
Specify the IP address or the host name of the Remote Console Connection Unit installed for the

UNIX server to be added.

An abbreviation is impossible.

To specify the connecting host by using up to 255 alphanumeric characters is required.

● Spaces and colons (:) cannot be included.

● There are some notes about additional UNIX servers.  For details, refer to “C.1 UNIX

Servers Managed by RC2000” in Appendix C, "Notes.”

3.3.2.2 Registered Name
Specify the string to be displayed in the host browser.  Specify a string that is unique in the
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"Host" group of the host browser.  The registered strings cannot be specified.

If omitted, the string specified in the [Connecting Host] field is adopted.

To specify the name by using up to 255 alphanumeric characters is required.

● Spaces and colons (:) cannot be included.

3.3.2.3 Port
Specify the port number used for connection in [Connecting Host].  Furthermore, specify the

read/write operation port of the Remote Console Connection Unit.

An abbreviation is impossible.

To specify an integer between 1 and 65535 is required.

The default value is 23.

● For information regarding the read/write operation port of The Remote Console

Connection Unit, refer to the “REMOTE CONSOLE CONNECTION UNIT USER’S

MANUAL.”
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3.4 Changing host
The host change dialog box is displayed by selecting [Change Host...] of the [File] menu in the

master control window.

In the host change dialog box, the display name of a host shown in the host browser (that belongs

to the "Host" group) can be changed.

The UNIX server for the "Host" group is added using the host addition function.

This section describes how to change hosts.

● Because of access restrictions, the [Change Host ...] menu cannot be selected by users

who have no permission to operate OS consoles of UNIX servers that are not UNIX

servers with the partition function that are managed by the system console.  For details,

refer to “Access restrictions” in “1.3 Access to OS Consoles.”

3.4.1 Screen layout of the host change dialog box

In the host change dialog box, the registered UNIX server name selected from the host browser

can be changed.

The connecting host and port cannot be changed.

If they need to be changed, delete the proper UNIX server, and then add the new one.

For adding hosts, see "3.3 Adding hosts."

The screen layout is shown below.

Host change dialog box

[Dialog box title]
The dialog box title "Change Host" is displayed on the upper part of the host change

dialog box.

[Setting item]
Each item to be set in the host change dialog box is displayed.  For each item, refer to

"3.4.2 Items in the host change dialog box."
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Item
Connecting Host
Registered Name
Port

[Button]
The host change dialog box contains the following buttons:

 

[OK]
Changes the display string of the selected UNIX server in the host browser to

[Registered Name] before closing the host change dialog box.

 

[Cancel]
Closes the host change dialog box.  Changed settings do not become valid.

3.4.2 Items in the host change dialog box

This section describes each item in the host change dialog box.

3.4.2.1 Connecting Host
The connecting UNIX server of the host selected from the host browser is displayed.

No input is allowed.

● If the connecting host needs to be changed, delete the proper host, and then add the new

one.

3.4.2.2 Registered Name
Specify the string to be displayed in the host browser.

Specify a string that is unique in the "Host" group of the host browser.

The registered strings cannot be specified.

If omitted, the string specified in the [Connecting Host] field is adopted.

To specify the name by using up to 255 alphanumeric characters is required.

When this dialog box appears, the registered name of the UNIX server selected in the host

browser is displayed.

● Spaces and colons (:) cannot be included.
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3.4.2.3 Port
The port of the UNIX server selected from the host browser is displayed.

No input is allowed.

● If the port needs to be changed, delete the proper UNIX server, and then add the new one.
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3.5 Environment setting/saving
The environment setting dialog box is displayed by selecting [Set Environment...] of the [Settings]

menu in the master control window.

In the environment setting dialog box, the operating environment of the selected UNIX server can

be set up.

Settings made in the environment setting dialog box can be saved so that they can be reflected

on the environment the next time RC2000 is started.

This section describes the environment setting dialog box.

3.5.1 Screen layout of the environment setting dialog box

In the environment setting dialog box, the operating environment for the console window

corresponding to the selected UNIX server can be set.

If only one UNIX server is selected when the environment setting dialog box is displayed, the

contents of the UNIX server are displayed.

If there are two or more selected UNIX servers, the default values of RC2000 are displayed,

regardless of the UNIX server contents.

The screen layout is shown below.

Environment setting dialog box
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[Dialog box title]
The dialog box title "Environment Setting (-<Host name> : <group name>)" is displayed on

the upper part of the environment setting dialog box.  (-<Host name> : <group name>) is

displayed if only one UNIX server is selected.

<Host name> is a string displayed in the host browser.  <group name> is the name of the

group to which the selected UNIX server belongs.

[Setting items]
Each item to be set in the environment setting dialog box is displayed.

For each item, refer to "3.5.2 Items in the environment setting dialog box."
Item

Code Converting Mode
Function Key Mode
Lines To Be Scrolled
Wrap Around
Reverse Wrap Around
Foreground
Background
Font Size
Data Arrival
Mouse Type

[Buttons]
The environment setting dialog box has the following buttons:

 

[Reflect]
Validate the environment setting on the selected console window and closes the

environment setting dialog box.

If the console window is not activated, it is effective right after activating it.

If the console window is already activated, the setting is valid immediately.

To save the setting when RC2000 is activated next time, select the [Save&Reflect]

button.

 

[Save&Reflect]
Validate the environment setting as RC2000 management information in the

console window, and save it on the management server machine in server/client

operation mode or on a client machine in local operation mode.  Also, exit the

environment setting dialog box.

The confirmation message dialog box “Are you sure you want to continue save

processing?” is displayed.  Selecting the [OK] saves the environment.

If the console window is not activated, it is effective right after activating it.

If the console window is already activated, the setting is valid immediately.

When RC2000 is activated next time, this setting is still valid.

In server/client operation mode, environment settings are saved as RC2000

management information on the management server for each user.  This also

applies to operations on client machines.  Therefore, the environment settings are

used for all relevant operations of RC2000 started by the same user.

In local operation mode, the environment settings are saved as RC2000

management information on the client machines for each user.
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[Default]
Resets all items to their default values.  The environment setting dialog box is not

closed.

 

[Cancel]
Closes the environment setting dialog box.  Changes to the environment setting do

not become valid.

3.5.2 Items in the environment setting dialog box

This section describes each item in the environment setting dialog box.

3.5.2.1 Code Converting Mode
Specify the locale of data output from the UNIX server.

Select the conversion code by clicking the list, or select by entering the first few characters on the

keyboard.

In server/client operation mode, the default mode is the starting locale of the Web browser.  In

local operation mode, the default mode is the RC2000 starting locale.

3.5.2.2 Function Key Mode
Specify the ESC sequence to be sent when pressing the function key.

When running a program using “curses" in the console window, the appropriate ESC sequence

depends on the terminal properties supported by the program.

[xterm] or [S] can be selected as the function mode.

[xterm] is selected by default.

3.5.2.3 Lines To Be Scrolled 
Specify the number of lines in the scroll buffer.

The scroll buffer is used to save invisible lines behind the top of the screen.

The setup of specifying an integer between 24 and 32767 is required.  An abbreviation is

impossible.

The default value is 5120.

3.5.2.4 Wrapping

Wrap Around
Specify whether to automatically wrap around data exceeding a single line at the line end in the

console window.

If checked, wrapping occurs automatically at the line end if data exceeds one line of the window.

This item is checked by default.
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Reverse Wrap Around
Specify whether to reverse-wrap around, in multiple lines, to the end of the previous line by using

the Backspace key in the console window.

If checked, reverse-wrapping to the end of the previous line occurs by using the Backspace key if

one line is wrapped around when exceeding the end of one line of the window.

This item is unchecked by default.

3.5.2.5 Color

Foreground
Specify the foreground color of the console window.

Select the color in the color dialog box displayed by selecting the foreground color button.

The default foreground color is black.

Background
Specify the background color of the console window.

Select the color in the color dialog box displayed by selecting the background color button.

The default background color is white.

3.5.2.6 Font Size
Specify the font size to be used in the console window.

Select the font size by clicking on the list.

The optional size is 6, 8, 10, 12, 16, 24, 28, 32, 36, 40, 48, 56, and 64.

The default font size is 12 points.

● Actually, the size varies depending on the font used in the system.  The size might not be

changed as specified.

3.5.2.7 Data Arrival
Specify whether to report data output of the console.

If checked, "DATA" is displayed in the host browser icon, and data output is monitored.

When the data is output of the console window, the host browser icon turns red.

It is checked by default.

3.5.2.8 Mouse Type
Specify the mouse type.
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Select either [2 Button Mouse] or [3 Button Mouse].

[3 Button Mouse] is selected by default.

When [3 Button Mouse] is selected, the functions of each button on the mouse are as follows:

Button 1
Copies a selection as indicated below.

― Drag:  Specifies the copying range.

― Double-click: Selects the word at the click position.

― Triple-click:  Selects the line at the click position.

Button 2
Pastes copied data in at the click position.

Button 3
Copies a range from the last click position to the current click position.

If [2 Button Mouse] is selected, the functions of Button 1 and Button 2 can be used.  The

functions of Button 3 are not available.

● When using a three-button mouse, left button, middle button, and right button correspond

to Button 1, Button 2, Button 3, respectively.

When using a two-button mouse, left button and right button correspond to Button 1 and

Button2, respectively.

● In the operation on non-management server, the default varies depending on the

operating system that starts RC2000.  The default setting for each operating system is as

follows:

― Solaris OE

―  [3 Button Mouse] is selected by default.

― Windows

[2 Button Mouse] is selected by default.
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3.6 Startup setting
The startup setting dialog box is displayed by selecting [Set Starting...] from the [Settings] menu

in the master control window.  In the startup setting dialog box, setting related to RC2000 startup

can be made.

This section describes the startup setting.

● Restart RC2000 to validate the setup definitions.

● For RC2000 running on the Solaris OE system, items cannot be set if a user other than

the system administrator starts RC2000.  Such users can only check the settings

specified in the startup setting dialog box.  For RC2000 running on a Windows system,

items can be set regardless of the user who starts RC2000.

In server/client operation mode, RC2000 is started with the authority of the user who

started the Web browser.

● Information that is specified in the startup setting dialog box is saved on a client machine

in either server/client operation or local operation mode.

● The definitions are valid for all users on the machine where the startup is set up.  The

definition for each user is not available.

3.6.1 Screen layout of the startup setting dialog box

In the startup setting dialog box, the options and the window size when RC2000 startup can be

set.

The setting is valid when RC2000 is activated next time.

The screen layout is shown below.

Startup setting dialog box

[Dialog box title]
The dialog box title "Set Starting" is displayed on the upper part of the startup setting

dialog box.
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[Setting item]
Each item to be set in the startup setting dialog box is displayed.  For each item, refer to

"3.6.2 Items in the startup setting dialog box."
Item

JRE path
java option
rc2000 option
Resolution

[Button]
The startup setting dialog box has the following buttons:

[Select...] 
Displays the file dialog box used to select the path to Java(TM) 2 Runtime

Environment Standard Edition (hereafter referred to as JKE).  Selecting the top

directory of JRE in the file dialog box and clicking [Select], the directory is displayed

in the [JRE path] area.

 

[OK]
Exits the startup setting dialog box after saving setting information.  Settings are

enabled the next time RC2000 is activated.

 

[Cancel]
Closes the startup setting dialog box.  Changed settings do not become valid.

 

[Clear]
Clears the [JRE path] area, [java options] area, and [rc2000 options] area.  The

startup setting dialog box is not closed.

3.6.2 Items in the startup setting dialog box

This section describes each item of the startup setting dialog box.

3.6.2.1 JRE path
Specify the absolute path to the top directory of JRE Version 1.3.1 or later.

For example, if JRE1.3.1_02 is installed in /usr, the top directory of JRE is /usr/j2re1_3_1_02.

It is also possible to specify this path from the file dialog box displayed by clicking the [Select...]

button.

If the JRE path is already specified in the startup setting dialog box or by using the rcsetfontprop

command, its content is displayed.

● The version of the specified JRE is not checked.  RC2000 requires an environment that

has Version 1.3.1 or later in order to run.  For further information, refer to the applicable

installation guides prepared for RC2000 component products.

● If an invalid path is specified for “JRE path,” RC2000 may not start.
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In this event, check the execution environment, and specify the appropriate path to JRE

Version 1.3.1 or later by executing the rcsetfontprop command.  For information on the

rcsetfontprop command, refer to “A.2 rcsetfontprop.”

● Two or more versions of JRE may be installed on a machine running RC2000.  To use a

specific version of JRE in this environment, specify its top directory for “JRE path.”

If no JRE path is specified and Solaris OE is used, RC2000 runs using the JRE in the

initial setting of environment variable PATH specified by the starting user.

If Windows is used, RC2000 runs using the JRE that is first in the OS installation software

management sequence.

3.6.2.2 java option
Specify an option of the java command.

If the option of the java command is already specified in the startup setting dialog box, its content

is displayed.

A memory shortage may occur depending on the number of open console windows and the

environment settings.

To prevent a memory shortage, use an option, such as for changing the maximum size of the

memory allocation pool for the memory area to be allocated to Java Virtual Machine.

For example, to set a maximum memory size of 128 MB, specify "-Xmx128m."

For the java command options, refer to the Java(TM)2 SDK documentation of Sun Microsystems,

Inc.

For information about the java command options of JRE1.3 or later, refer to the following:

Java(TM) 2 SDK, Standard Edition Documentation -> SDK Tool Documentation -> java – the

Java application launcher.

● For the changing of the memory maximum size at the time of memory shortage occurring,

refer to "Corrective action 3" of "Symptom 23: Copying by double-clicking fails in

[Command input area] in the shared command input dialog box" in "D.1 Corrective action

to a Problem."

● If the incorrect setup is done for the java option, RC2000 might not be started.

Refer to "Symptom 1: RC2000 cannot be started" in Appendix D, "Troubleshooting."

3.6.2.3 rc2000 option
Specify the option of the rc2000 command.

It will be used when a trouble occurs.

3.6.2.4 Resolution
Specify the display resolution.

The size of the master control window on RC2000 startup is modified to the recommended value

suitable for the specified resolution.
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If the resolution is already specified in the startup setting dialog box, its content is displayed.
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3.7 Common command input
The common command input dialog box is displayed by selecting [Common Input...] from the

[Execute] menu in the master control window.

In the common command input dialog box, any command can be input to multiple operating the

OS consoles simultaneously.

This section describes the common command input function.

3.7.1 Screen layout for common command input dialog box

In the common command input dialog box, commands to be sent to the selected UNIX server can

be entered.

The screen layout is shown below.

Common command input dialog box

[Dialog box title]
The dialog box title "Common Command Input" is displayed on the upper part of the

common command input dialog box.

[Item]
The following items are displayed in the common command input dialog box.  For each

item, refer to "3.7.2 Items in the common command input dialog box."
Item

Command history display area
Command input area
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[Button]
The following button is displayed in the common command input area:

 

[Close]
Closes the common command input dialog box.

3.7.2 Items in the common command input dialog box

This section describes each item of the common command input dialog box.

3.7.2.1 Command history display area
Histories of strings sent to the UNIX server from [Command input area] is displayed.

The contents exceeding [Command input area] can be referred by scrolling the window with a

scroll bar.

The selected string can be copied by double clicking or dragging with mouse button 1.  The

copied string can be pasted to [Command input area].

For the [Command input area], refer to "3.7.2.2 Command input area" in "3.7.2 Items in the

common command input dialog box."

3.7.2.2 Command input area
Input an arbitrary command string to be sent.

Input strings are sent to the console when they are entered from the keyboard.

By pressing the Enter key, this string is cleared off from [Command input area] and is displayed in

[Command history display area].

Copying and pasting are enabled by using a mouse.  The copying of the string is also enabled

by dragging or double clicking with a mouse button 1, and then pastes it by clicking mouse button

2.  The string copied at [Command history display area] can also be pasted.

● Commands are sent, among the selected UNIX servers, to the corresponding activate

console windows in which read/write operations are enabled.
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3.8 Changing Settings
This section explains how to change values that have already been set.

3.8.1 Changing the port number of the management server

function (RC2000 server daemon)

In server/client operation mode, RC2000 accesses the RC2000 server daemon that provides the

management server function of the management server machine.  RC2000 then acquire and

saves RC2000 management information managed by the management server machine.

The default access port number used to access the RC2000 server daemon is 5500.  Change

the port number if it conflicts with the default port number of another product.

Execute the following command on the management server to change the settings:

      # /etc/opt/FJSVrcon/bin/rc2ksdsetup –p number add

Use "number" to specify the number of a port to be used.

For the rc2ksdsetup command , refer to "A.4 rc2ksdsetup."

Execute the following command to check the current settings:

      # /etc/opt/FJSVrcon/bin/rcget2ksdport

      5500

For the rcget2ksdport command , refer to “A.5 rcget2ksdport.”

● Have the system administrator change the settings.

● After the settings are changed, reboot the management server machine.





Appendix A Command Reference

This appendix explains the commands provided by RC2000.

A.1 rclocal (1) 

[Name]
rclocal

 

[Format]
Solaris OE

/etc/opt/FJSVrcon/bin/rclocal

Windows

<RC2000_installation_folder>¥RC2000¥bin¥rclocal.exe

 

[Function description]
rclocal starts the Java application (RC2000) for operating an OS console.

rclocal collects RC2000 management information from the client machines and displays a

list of UNIX servers that control the OS console.

rclocal also saves RC2000 management information that is defined during RC2000

operation to the client machines.

This command can be used only in local operation mode.

 

[Option]
None

 

[End status]
The following end status is returned:

0:  Normal termination.

non-zero:  Abnormal termination.

 

[Warning remarks]
To use this command in Solaris OE, the path to JRE Version 1.3.1 or later and the

DISPLAY variable must be specified in advance.

A.2 rcsetfontprop (1M) 

[Name]
rcsetfontprop

 

[Format]
/etc/opt/FJSVrcon/bin/rcsetfontprop [jrepath]

 

[Function description]
rcsetfontprop places the font property file required to operate RC2000 in the specified JRE

directory or deletes it from the directory.
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It also adds or deletes the path definition of the java command that starts RC2000.

 

[Option]
The following option is available:

jrepath
Specify the absolute path to the top directory of JRE.

If this designation is omitted, the font property file of the JRE directory placed by this

command and the path definition of the java command that starts RC2000 are

deleted.

 

[End status]
The following end status is returned:

0: Normal termination.

non-zero: Abnormal termination.

 

[Warning remarks]
Only the system administrator is allowed to execute this command.

Specify the path to JRE Version 1.3.1 or later.

This command must always be executed after RC2000 is installed under Solaris OE.  For

further information, refer to the installation guides of the RC2000 component products.

 

A.3 rcextsetup (1M)

[Name]
rcextsetup

 

[Format]
/etc/opt/FJSVrcon/bin/rcextsetup [jreextpath]

 

[Function description]
rcextsetup places or deletes the environment for starting RC2000 from the menu of Web-

Based Admin View to the specified JRE directory.

This command can be executed only in server/client operation mode.

 

[Option]
The following option is available:

jreextpath
Specify the absolute path to the "ext" directory of JRE.

The environment for starting RC2000 from the menu of Web-Based Admin View is

placed in the specified jreextpath directory.

When this option is omitted, the environment for activating RC2000 from the Web-

Based Admin View menu is deleted.

 

[End status]
The following end status is returned:

0: Normal termination.

non-zero: Abnormal termination.

 



A.4 rc2ksdsetup (1M)

59

[Warning remarks]
Only the system administrator is allowed to execute this command.

Specify the "ext" directory that the version is JRE1.3 or later, and that is for downloading

Java Plug-in of the Web browser.

This command must always be executed after RC2000 is installed under Solaris OE.  For

further information, refer to the installation guides of the RC2000 component products.

A.4 rc2ksdsetup (1M)

[Name]
rc2ksdsetup

 

[Format]
/etc/opt/FJSVrcon/bin/rc2ksdsetup [-p number] add | chk

 

[Function description]
rc2ksdsetup performs a setup of the port number which RC2000 server daemon uses,

change, and a check.

This command can be used only in server/client operation mode.  Execute it on the

management server machine.

 

[Option]
The following option is available:

-p number
Specify RC2000 server daemon's port number.

When this option is omitted, it operates as that the default port number (5500) was

specified to be.

This option is surely described at the head of an option. 

add
The definition of RC2000 server daemon's port number is changed into the port

number specified as -p option.

chk
It checks whether the port number specified as the -p option is defined.

 

[End status]
The following end status is returned:

0 :
When the add option was specified, change for the specified port number was

completed normally.

When the chk option is specified, the definition of the specified port number does

not exist.

1 :
When the chk option is specified, the definition of those other than RC2000 server

daemon exists in the specified port number.

2 :
When the chk option is specified, the definition of RC2000 server daemon has

already existed in the specified port number.

3 :
When the chk option is specified, two or more definitions exist in the specified port

number.
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Other :
Abnormal termination.

 

[Warning remarks]
Only the system administrator is allowed to execute this command.

After the settings are changed, reboot the management server machine.

A.5 rcget2ksdport (1M)

[Name]
rcget2ksdport

 

[Format]
/etc/opt/FJSVrcon/bin/rcget2ksdport

 

[Function description]
rcget2ksdport outputs RC2000 server daemon's port number defined now to standard

output.

This command can be used only in server/client operation mode.  Execute it on the

management server machine.

 

[Function description]
None.

 

[End status]
The following end status is returned:

0: Normal termination.

non-zero: Abnormal termination.

 

[Warning remarks]
Only the system administrator is allowed to execute this command.



Appendix B Messages

This appendix explains the messages displayed by RC2000. 

B.1 Confirmation messages

The following messages indicate to confirm whether to continue processing.

The following icon indicates a confirmation message:

B.1.1 Messages displayed in host browser

Message Are you sure you want to continue host deletion?
Meaning Confirms whether to continue host deletion.
Action OK:  Continues the host deletion.

Cancel:  Aborts host deletion.

Message You are already connected to the host.  Are you sure you want to continue processing?
Meaning There is a window having an open connection to the host.
Action OK:  Continues with exit processing.

Cancel:  Aborts exit processing.

Message Are you sure you want to continue update processing?
Meaning Confirms whether to update the display.
Action OK:  Continues the update processing.

Cancel:  Aborts update processing.

Message Are you sure you want to continue forced connection?
The console window currently connected will be disconnected.

Meaning Confirms whether to perform forced connection.
Action OK:  Continues establishing a forced connection.

Cancel:  Aborts the processing for forced connection.

B.1.2 Message displayed in console window

Message Are you sure you want to move to the OpenBoot environment?
Meaning Confirms the transmission of the Break signal.
Action OK:  Send the Break signal.

Cancel:  Do not send the Break signal.
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B.1.3 Message displayed in environment setting dialog box

Message Are you sure you want to continue save processing?
Meaning Confirms whether to save settings in the environment setting file.
Action OK:  Saves settings in the environment setting file.

Cancel:  Does not save settings in the environment setting file.

B.2 Error messages

The following messages indicate information about system errors and application errors.

The following icon indicates an error message:

B.2.1 Messages displayed in host browser

Message Failed to acquire the host information.
Meaning There are the following possibilities.

(1) UNIX server information that the system console manages cannot be acquired.
(2) The UNIX server that the system console manages has not been turned on.

Action Perform an action as shown below and then restart RC2000 or execute [Update] from the
[File] menu in the master control window.
(1) Execute following command on a system console.

# /etc/init.d/FJSVscsl restart

Even if it execute the command, when fails to acquire, review the settings for the Machine
Administration.
(2) Check the state of the UNIX server with the partition function and turn it on if necessary.

Message Failed in the connection.
Meaning There are the following possibilities.

(1) The network environment contains an error.
(2) If a connection failure occurs, the state at the time of the failure may have been cached.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Restart RC2000.

Message The connection is closed.
Meaning There are the following possibilities.

(1) A network environment error occurred.
(2) An error of the RC2000 server daemon (rc2ksd) occurred.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Check a management server environment.

Message An error occurred in communication.
Meaning There are the following possibilities.

(1) A network environment error occurred.
(2) The operating environment for the RC2000 server daemon (rc2ksd) is incorrect. 
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(3) An error of the RC2000 server daemon (rc2ksd) occurred.
(4) If a connection failure occurs, the state at the time of the failure may have been cached.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Refer to "3.8.1 Changing the port number of the management server function (RC2000
server daemon)," and check the port number of the RC2000 server daemon.  Change the
port number if it conflicts with the port number of another product.
(3) Check the environment of the management server machine.
(4) Restart RC2000.

Message Failed to start the console window.
Meaning There is insufficient resource.
Action Close unnecessary console windows and then restart the console window.

Message An internal error occurred.
Meaning An internal error occurred during connection to the daemon (scfconsd) connected to the

server or to the Remote Console Connection Unit.
Action Notify the error to our technical support staff.

Message Failed to read the saved environment.
Default settings are used for operation.

Meaning Failed to read from the environment save file.
The user might not have the authority to read the file.

Action Notify the error to our technical support staff.

Message Failed to read the saved environment.
Connection could not be established.
Default settings are used for operation.

Meaning The environment save file could not be read.  There are the following possibilities.
(1) A network environment error occurred.
(2) The operating environment for the RC2000 server daemon (rc2ksd) is incorrect.
(3) An error of the RC2000 server daemon (rc2ksd) occurred.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Refer to "3.8.1 Changing the port number of the management server function (RC2000
server daemon)," and check the port number of the RC2000 server daemon.  Change the
port number if it conflicts with the port number of another product.
(3) Check the environment of the management server machine.

Message Failed to restore the saved environment.
An error is in the contents of an environment save file.
Reading was stopped because the number of hosts that cannot be restored exceeded 10.
Hosts which could not be restored.

Meaning The environment save file might not have the correct format.
Action Execute [Set Environment...] for hosts for which restoring failed by selection from the

[Settings] menu in the master control window to make the settings again.

Message Failed to restore the saved environment.
An error is in the contents of an environment save file.
Hosts which could not be restored.

Meaning The environment save file might not have the correct format.
Action Execute [Set Environment...] for hosts for which restoring failed by selection from the

[Settings] menu in the master control window to make the settings again.

Message Failed to read the menu definition file.
Connection could not be established.

Meaning The menu definition file could not be read.  There are the following possibilities.
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(1) A network environment error occurred.
(2) The operating environment for the RC2000 server daemon (rc2ksd) is incorrect.
(3) An error of the RC2000 server daemon (rc2ksd) occurred.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Refer to "3.8.1 Changing the port number of the management server function (RC2000
server daemon)," and check the port number of the RC2000 server daemon.  Change the
port number if it conflicts with the port number of another product.
(3) Check the environment of the management server machine.

Message Failed to read the menu definition file.
The file does not exist or the read authority is not granted.

Meaning The menu definition file could not be read.  There are the following possibilities.
(1) The menu definition file does not exist.
(2) The authority to read the menu definition file is not granted.

Action Notify the error to our technical support staff.

Message An error is in the contents of a menu definition file.
Meaning The menu definition file might not have the correct format.
Action Notify the error to our technical support staff.

Message Failed to read the menu definition file.
Meaning The menu definition file could not be read.  There are the following possibilities.

(1) A network environment error occurred.
(2) An error of the RC2000 server daemon (rc2ksd) occurred.
(3) The menu definition file entered an error status.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Check the environment of the management server machine.
(3) Notify the error to our technical support staff.

Message Failed to read the host information file.
The file does not exist or the read authority is not granted.
Processing is continued.

Meaning The host information file could not be read.  There are the following possibilities.
(1) The host information file does not exist.
(2) The user does not have the authority for reading the host information file.

Action Check whether the following file exists or is in use.  Also check whether the user has the
authority for reading the file.
For Solaris OE:
● /etc/opt/FJSVrcon/config/host_config
For Windows:
● <RC2000_installation_folder>¥host_config

Message An error is in description of the host information file.
Meaning The RC2000 host information file provided by System Console Software (SCS) already

exists.
Action Delete the $HOME/.rc2000/.rcmanager file.

B.2.2 Messages displayed in console window

Message Normal operation cannot be performed due to insufficient memory.
Meaning There is insufficient memory.
Action Close unnecessary console windows and then retry.
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If this message is output repeatedly, carry out "Corrective action 1" and "Corrective action 3"
of "Symptom 25: RC2000 is disabled or ended without any notification" in "D.1 Corrective
action to a Problem," and restart RC2000.

Message Failed in the connection.
Meaning There are the following possibilities.

(1) The daemon (scfconsd) that should be connected with the UNIX server does not exist.
(2) A network environment error occurred.
(3) An error is in the specification of [Connecting Host] or [Port] in a host addition dialog box.
(4) The power supply of the Remote Console Connection Unit may not be on.
(5) If a connection failure occurs, the state at the time of the failure may have been cached.

Action Perform an action as shown below.
(1) Execute the ps command on the system console to confirm that the daemon (scfconsd)
connected to the UNIX server exists.  If the daemon does not exist, notify the error to our
technical support staff.
(2) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(3) Execute [Change Host...] from the [File] menu in the master control window, and review
the specification of [Connecting Host] or [Port] in a host change dialog box.
(4) Check the status of the Remote Console Connection Unit that is installed on the UNIX
server added using the host addition function.
(5) Restart RC2000.

Message Failed in the connection because of the security exception.
Meaning Failed in the connection because of the security exception.
Action Review the security environment.

Message An error occurred in communication.
Meaning There are the following possibilities.

(1) There is insufficient memory.
(2) A network environment error occurred.

Action Perform an action as shown below.
(1) Close unnecessary console windows and then retry.
(2) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.

Message The connection is closed because forced connection was performed.
Meaning Forced connection was performed.
Action Switch to read-only monitoring and start.

Message The maximum number of console windows for read/write operations is already started.
Meaning The maximum number of console windows for read/write operations is already started.
Action It is not possible to connect until the started console window is closed. Reconnect after

waiting for a while or switch to read-only monitoring and start.

Message The maximum number of console windows for read-only monitoring is already started.
Meaning The maximum number of console windows for read-only monitoring is already started.
Action It is not possible to connect until the started console window is closed. Reconnect after

waiting for a while.

Message Failed in the connection because configuration of the server is changed.
Meaning The configuration changes to the UNIX servers that the system console manages have not

been reflected in the host browser.
Action Execute [Update...] by selecting it from the [File] menu in the master control window.

Message System network has not been activated.
Meaning System network has not been activated.
Message Select [System Network Administration] -[System Network Configuration Tools] from the 
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System Console Machine Administration menu and activate the system network.

Message Setting necessary for the connection with Console Connection Unit is not done.
Meaning The Console Connection Unit is not set.
Action Select [System-Specific Administration] -[Console Connection Unit (CCU) Setup] from a

system console Machine Administration menu and set with Console Connection Unit.

Message An error was detected when connecting to the Console Connection Unit.
Meaning The Console Connection Unit cannot be accessed.
Action Notify the error to our technical support staff.

Message An internal error occurred.
Meaning An internal error occurred on the system console during connection to the daemon (scfconsd)

connected to the UNIX server.
Action Notify the error to our technical support staff.

Message A system error occurred.
Meaning The daemon (scfconsd) connected to the UNIX server was disabled on the system console.
Action Notify the error to our technical support staff.

B.2.3 Messages displayed in host addition dialog box

Message Failed to save the host information.
The current host information is only valid until RC2000 is shut down.

Meaning The host information could not be saved in the host information file.
The authority to write to the file might not be granted.

Action Check whether the following file exists or is in use.  Also check whether the user has the
authority for reading the file.
For Solaris OE:
● /etc/opt/FJSVrcon/config/host_config
For Windows:
● <RC2000_installation_folder>¥host_config

Message Failed to save the host information. Connection could not be established. The current host
information is only valid until RC2000 is shut down.

Meaning The host information could not be saved in the host information file.
There are the following possibilities.
(1) A network environment error occurred.
(2) The operating environment for the RC2000 server daemon (rc2ksd) is incorrect.
(3) An error of the server RC2000 daemon (rc2ksd) occurred.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Refer to "3.8.1 Changing the port number of the management server function (RC2000
server daemon)," and check the port number of the RC2000 server daemon.  Change the
port number if it conflicts with the port number of another product.
(3) Check the environment of the management server machine.

B.2.4 Messages displayed in host change dialog box

Message Failed to save the host information.
The current host information is only valid until RC2000 is shut down.

Meaning The host information could not be saved in the host information file.
The authority to write to the file might not be granted.
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Action Check whether the following file exists or is in use.  Also check whether the user has the
authority for reading the file.
For Solaris OE:
● /etc/opt/FJSVrcon/config/host_config
For Windows:
● <RC2000_installation_folder>¥host_config

Message Failed to save the host information. Connection could not be established. The current host
information is only valid until RC2000 is shut down.

Meaning The host information could not be saved in the host information file.
There are the following possibilities.
(1) A network environment error occurred.
(2) The operating environment for the RC2000 server daemon (rc2ksd) is incorrect.
(3) An error of the server RC2000 daemon (rc2ksd) occurred.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Refer to "3.8.1 Changing the port number of the management server function (RC2000
server daemon)," and check the port number of the RC2000 server daemon.  Change the
port number if it conflicts with the port number of another product.
(3) Check the environment of the management server machine.

B.2.5 Messages displayed in environment setting dialog box

Message Failed to save the environment.
The current environment settings are only valid until RC2000 is shut down.

Meaning The environment could not be saved in the environment save file.
The authority to write to the file might not be granted.

Action Notify the error to our technical support staff.

Message Failed to save the environment.
Connection could not be established.
The current environment settings are only valid until RC2000 is shut down.

Meaning The environment could not be saved in the environment save file.  There are the following
possibilities.
(1) A network environment error occurred.
(2) The operating environment for the RC2000 server daemon (rc2ksd) is incorrect.
(3) An error of the RC2000 server daemon (rc2ksd) occurred.

Action Perform an action as shown below.
(1) Check the network environment of the management server machine.  For operation on a
client machine, also check the network environment of the client machine.
(2) Refer to "3.8.1 Changing the port number of the management server function (RC2000
server daemon)," and check the port number of the RC2000 server daemon.  Change the
port number if it conflicts with the port number of another product.
(3) Check the environment of the management server machine.

B.2.6 Message displayed in startup setting dialog box

Message Failed to write the definition file.
Meaning Information could not be written to the definition file.
Action Check the access authority to the files below, and make sure that the files are not being

referenced.
For Solaris OE :
● /etc/opt/FJSVrcon/config/rc2000_config
● /etc/opt/FJSVrcon/config/java_config
● /etc/opt/FJSVrcon/config/edef_config
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For Windows:
● <RC2000_installation_folder>¥rc2000_config
● <RC2000_installation_folder>¥java_config
● <RC2000_installation_folder>¥edef_config

B.3 Information messages

The following messages indicate general information.

The following icon indicates an information message:

B.3.1 Message displayed in host browser

Message The host information is under acquisition.
Meaning The host information is under acquisition.

Message A system clipboard cannot be used.
Meaning A system clipboard cannot be used.  An original clipboard will be created for RC2000.

The copy & paste function can be used between RC2000 console windows.
However, it cannot be used between an RC2000 console window and common command
input dialog box.
For more information, refer to “C.5 Copy and paste” in Appendix C, “Notes.”

B.3.2 Messages displayed in console window

Message The connection is closed.
Meaning There are the following possibilities.

(1) The connection from the daemon (scfconsd) connected to the UNIX server that is
managed by the system console was lost.
(2) The added UNIX server may have already been connected by others.
(3) Power to the Remote Console Connection Unit was turned off or the unit was reset to off.
(4) The connection was closed by the PRIMECLUSTER console asynchronous monitoring
feature.
(5) A network environment error occurred.

Action Perform an action as shown below.
(1) Execute the ps command on the system console to confirm that the daemon (scfconsd)
exists.  If the daemon does not exist, notify the error to our technical support staff.
(2) It is not possible to connect until the started console window is closed. Reconnect after
waiting for a while.
(3) Check the status of the Remote Console Connection Unit that is installed on the UNIX
server added using the host addition function.
(4) Connection to the UNIX server is not possible while it is being used by the cluster console
asynchronous monitoring feature.  Reconnect after waiting for a while.
(5) Check the environment of the management server machine.

Message A system clipboard cannot be used.
Meaning The system clipboard is not available because of the security settings.
Action Review the Java security settings.
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B.3.3 Messages displayed in environment setting dialog box

Message An error is in the specification of the Connecting Host. Input it again.
Meaning The Connecting Host is not set up, or a string of 255 bytes or more is specified.
Action Specify the correct value to be the Connecting Host.

Message The specified registration name cannot be registered because it has already been used. Input
it again.

Meaning An error is in the input of the Registered Name.
Action Specify the correct value to be the Registered Name.

Message An error is in the specification of the Port. Input it again.
Meaning A numeric value outside a range of 1 to 65535 or a non-integer number is specified for the

Port.  Alternatively, the Port is not specified.
Action Specify the correct value to be the Port.

B.3.4 Message displayed in host change dialog box

Message The specified registration name cannot be registered because it has already been used. Input
it again.

Meaning An error is in the input of the Registered Name.
Action Specify the correct value to be the Registered Name.

B.3.5 Message displayed in environment setting dialog box

Message Specify a value from 24 to 32767 as the number of Lines To Be Scrolled.
Meaning A numeric value outside the range of 24 to 32767 or a non-integer number is specified for the

number of Lines To Be Scrolled.  Otherwise, the number of lines is not set up.
Action Specify the correct value for the number of Lines To Be Scrolled.

B.3.6 Message displayed in startup setting dialog box

Message An error is in the specification of JRE path. Input it again.
Meaning There are the following possibilities.

(1) The specified JRE path is not an absolute path.
(2) The specified JRE path does not exist.

Action Perform one of the actions described below, according to the above possibility (1) or (2), and
then restart RC2000:
(1) Specify the absolute path to JRE Version 1.3.1 or later.
(2) Specify the path to JRE Version 1.3.1 or later.

B.4 Command messages
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B.4.1 rclocal command messages

Solaris OE
Message rclocal: Please set up DISPLAY variable.
Meaning The DISPLAY variable is not specified.
Action Specify the DISPLAY variable, and restart RC2000.

Message rclocal: Can’t find java command.
Meaning java command cannot be found.

JRE Version 1.3.1 or later is probably not installed.
Action Enter the rcsetfontprop command to specify the path to JRE Version 1.3.1 or later, and restart

RC2000.  For information on the rcsetfontprop command, refer to “A.2 rcsetfontprop.”

Message rclocal: The version of java command isn’t right.
Meaning The java command version is invalid.

JRE Version 1.3.1 or later is probably not installed.
Action Enter the rcsetfontprop command to specify the path to JRE Version 1.3.1 or later, and restart

RC2000.  For information on the rcsetfontprop command, refer to “A.2 rcsetfontprop.”

Message rclocal: Abnormal End.
Meaning There are the following possibilities.

(1) The user does not have the authority for accessing X.
(2) The java command terminated abnormally.

Action Perform one of the actions described below, according to the above possibility (1) or (2):
(1) Confirm that the user has access authority, and if not, assign authority to access X
according to the authentication protocol that is being used.  
To check whether the user has access authority, execute the following command on the
machine on which RC2000 is running:
   $ /usr/openwin/bin/xhost
For information on assigning authority to access X, refer to "Allowing Access When Using
MIT-MAGIC-COOKIE-1" or "Allowing Access When Using SUN-DES-1" in the "Solaris X
Window System Developer's Guide" of "Sun Microsystems, Inc. AnswerBook 2."
(2) Notify the error to our technical support staff.

Message rclocal: Failed to exec RC2000.
Meaning RC2000 could not be started.
Action Reinstall RC2000 software.

For installation procedure, refer to the applicable installation guides prepared for RC2000
component products.

Windows
Message Can’t find java command.
Meaning Java command cannot be found.  There are the following possibilities.

(1) JRE Version 1.3.1 or later is not installed.
(2) The path to the Java command is not build.

Action Perform one of the actions described below, according to the above possibility (1) or (2), and
then restart RC2000:
(1) Refer to the applicable installation guides prepared for RC2000 component products, and
install JRE Version 1.3.1 or later.
(2) Specify the path to JRE Version 1.3.1 or later.

Message The version of java command isn't right.
Meaning The java command version is invalid.  There are the following possibilities.

(1) JRE Version 1.3.1 or later is not installed.
(2) The path to the Java command is not built.

Action Perform one of the actions described below, according to the above possibility (1) or (2), and
then restart RC2000:
(1) Refer to the applicable installation guides prepared for RC2000 component products, and
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install JRE Version 1.3.1 or later.
(2) Specify the path to JRE Version 1.3.1 or later.

Message Failed to exec RC2000.
Meaning RC2000 could not be started.  There are the following possibilities.

(1) An error occurred in the client environment.
(2) The path to the Java command is not built.

Action Perform one of the actions described below, according to the above possibility (1) or (2), and
then restart RC2000:
(1) While referring to the applicable installation guides prepared for RC2000 components,
review the client environment in which RC2000 starts and restart the client machine.  If
RC2000 still fails to start, reinstall RC2000.  For the installation procedure, refer to the
applicable installation guides prepared for RC2000 component products.
(2) Specify the path to JRE Version 1.3.1 or later.

B.4.2 Messages of rcsetfontprop command

Message Usage: rcsetfontprop [jrepath]
Meaning An error is in the specification of option.
Action Specify the correct options.

Message rcsetfontprop: The specified path(XXX) isn’t full path.
Meaning The specified path is not an absolute path.
Action Specify the absolute path to the top directory of JRE.

Message rcsetfontprop: The specified path(XXX) doesn’t exist.
Meaning The specified path does not exist.
Action Check whether the specified path exists.

Message rcsetfontprop: The specified path(XXX) isn’t top directory to JRE.
Meaning The specified path is incorrect.  It might not be the path to the top directory of JRE.
Action Specify the correct absolute path to the top directory of JRE.

B.4.3 Messages of rcextsetup command

Message Usage: rcextsetup [path]
Meaning An error is in the specification of option.
Action Specify the correct options.

Message rcextsetup: The specified path(XXX) isn’t full path.
Meaning The specified path is not an absolute path.
Action Specify the correct absolute path to the "lib" directory of JRE.

Message rcextsetup: The specified path(XXX) doesn’t exist.
Meaning The specified path does not exist.
Action Check whether the specified path exists.

Message rcextsetup: The specified path(XXX) isn’t right.
Meaning The specified path is incorrect.  It might not be the path to the "ext" directory of JRE.
Action Specify the correct absolute path to the "ext" directory of JRE.
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B.4.4 Messages of rc2ksdsetup command

Message Usage: rc2ksdsetup [-p number] add | chk
Meaning An error is in the specification of option.
Action Specify the correct options.

Message rc2ksdsetup: /etc/inet/inetd.conf file does not exist.
Meaning /etc/inet/inetd.conf file does not exist.
Action Confirm that the /etc/inet/inetd.conf file exists.

Message rc2ksdsetup: /etc/inet/services file does not exist.
Meaning /etc/inet/services file does not exist.
Action Confirm that the /etc/inet/services file exists.

Message rc2ksdsetup: In the port number(XX), definition information on rc2ksd already exists.
Meaning The port number (XX) has already been defined as the port number of the RC2000 server

daemon (rc2ksd).

Message rc2ksdsetup: In the port number(XX), definition information other than rc2ksd exists.
Meaning The port number (XX) has already been defined as the port number of something other than

the RC2000 server daemon (rc2ksd).

Message rc2ksdsetup: In the port number(XX), Two or more definition information exists.
Meaning Two or more definitions exist for the port number (XX). Correct the settings to make sure that

definitions are not duplicate.

Message rc2ksdsetup: In the port number(XX), definition information does not exists.
Meaning No definition exists for the port number (XX).  Add a definition, if required.

B.4.5 Message of rcget2ksdport command

Message rcget2ksdport: /etc/inet/services file does not exist.
Meaning /etc/inet/services file does not exist.
Action Confirm that the /etc/inet/services file exists.

B.5 Messages from Web-Based Admin View

Message An error was detected in the Management Server environment setting.
Meaning An error occurred in the Web-Based Admin View environment on a management server

machine.
Action Check the Web-Based Admin View environment on a management server machine. For the

appropriate Web-Based Admin View environment, refer to "Web-Based Admin View
Operation Guide."

Message An error is in the starting environment of RC2000.
Meaning There are the following possibilities.
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(1) For operation on a client machine, RC2000 is not installed on the client machine.
(2) The environment for starting RC2000 from Web-Based Admin View may not be set up
correctly.

Action Perform an action as shown below.
(1) Check whether RC2000 is installed on the client machine.
(2) Refer to the applicable installation guides prepared for RC2000 component products, and
correctly set up the environment for starting RC2000 from the Web-Based Admin View.

Message Can’t find java command.
Meaning There are the following possibilities.

(1) JRE Version 1.3.1 or later is not installed.
(2) The path to the Java command is not built.

Action Perform an action as shown below and then restart Web browser.
(1) Refer to the applicable installation guides prepared for RC2000 component products, and
install JRE Version 1.3.1 or later.  For Solaris OE, specify the path to the JRE Version 1.3.1
or later by executing the rcsetfontprop command. For information on the rcsetfontprop
command, refer to “A.2 rcsetfontprop."
(2) Review the execution environment, and specify the path to JRE Version 1.3.1 or later by
executing the rcsetfontprop command.  For information on the rcsetfontprop command, refer
to “A.2 rcsetfontprop."

Message The version of java command isn’t right.
Meaning There are the following possibilities.

(1) JRE Version 1.3.1 or later is not installed.
(2) The path to the Java command is not built.

Action Perform an action as shown below and then restart Web browser.
(1) Refer to the applicable installation guides prepared for RC2000 component products, and
install JRE Version 1.3.1 or later.  For Solaris OE, specify the path to the JRE Version 1.3.1
or later by executing the rcsetfontprop command. For information on the rcsetfontprop
command, refer to “A.2 rcsetfontprop."
(2) Review the execution environment, and specify the path to JRE Version 1.3.1 or later by
executing the rcsetfontprop command.  For information on the rcsetfontprop command, refer
to “A.2 rcsetfontprop."

Message Failed to exec RC2000.
Meaning RC2000 could not be started.  There are the following possibilities.

(1) An error occurred in the server machine environment.
(2) An error occurred in the client machine environment.
(3) Information required for starting RC2000 could not be obtained.

Action Perform an action as shown below.
(1) Review the Web-Based Admin View environment of the management server machine, and
restart the management server machine.For the appropriate Web-Based Admin View
environment, refer to "Web-Based Admin View Operation Guide."
(2) For clients, refer to the applicable installation guides for RC2000 component products,
review the client environment settings for starting RC2000 from Web-Based Admin View, and
then restart the client machine.
(3) Check the port number of the RC2000 server daemon on the management server
machine.  If the port number is not defined, specify it.  For information on checking the port
number, refer to “A.5 rcget2ksdport.”  For information on specifying it, refer to “A.4
rc2ksdsetup.”

Message An error is in the specified parameter.
Meaning An error is in the specified parameter.

The settings of [rc2000 options] in the startup setting dialog box might be incorrect.
Action Delete the file settings below, and restart RC2000.

For Solaris OE:  /etc/opt/FJSVrcon/config/rc2000_config
For Windows:  <RC2000_installation_folder>¥rc2000_config





Appendix C Notes

This appendix explains notes on RC2000.

C.1 UNIX Servers Managed by RC2000

This section provides notes applicable to RC2000 management of UNIX servers without the

partition function.

In order to manage a UNIX server without the partition function, the Remote Console Connection

Unit must be mounted on the UNIX server.

The Remote Console Connection Unit can be accessed only from one network.  Mount a client

machine on the same network, and use RC2000.

● A UNIX server to be managed can be added to the host browser and deleted from it.

For details, refer to “2.3 Addition of host” and “2.4 Deletion of host.”

C.2 Host Browser

Symptom A selected host or group differs from one selected in advance.
Details A host had been selected on a system in which JRE1.4.0 is used and RC2000 is running.

Thereafter, use of a mnemonic key for menu operation selects a host or group different from
the host selected in advance or its group.

Action Use the mouse for menu operation.

C.3 Console

Symptom The status change icons might overlap the title of the console window.
Details When RC2000 is running and JRE1.3.1 is used, using a long console name may cause the

status change icons (maximize, minimize, and close) to overlap the displayed title.
Action None.

Symptom The horizontal width of the minimized console window is equal to the length of the title.
Details When RC2000 is running and JRE1.3.1 is used, the width of the minimized console window

is adjusted to the title length for display.  The minimized size might be irregular.
Action None.

Symptom Changing the name of the minimized window title changes the title name, too, and vice
versa.

Details If the minimized window title name is changed by using an ESC sequence, the title name is
also changed.  If the title name is changed, the minimized window title name is also
changed.

Action None.
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Symptom Line drawing characters are represented by "+" or "-."
Details When using a specific character set for line drawing with an ESC sequence, the line drawing

characters are represented by "+" or "-."
Action None.

Symptom When the data which is not based on a code system of the locale is contained in the data
outputted from a UNIX server, data may be unable to be displayed correctly.

Details When data, such as OS console message outputted from a UNIX server, includes the
combination of a code which is not based on the code system of the locale chosen in the code
converting mode of the environment setting dialog box, data may be unable to be displayed
correctly.  In this case, although "?" may be displayed, there is no problem in operation of the
UNIX server.

Action None.

Symptom If a keypad key is pressed while the Alt key is held down, input data may not be displayed
normally.

Details When RC2000 is running in WindowsXP, pressing a keypad key while holding down the Alt
key sometimes results in a failure in normal display of input data.

Action None.

C.4 Environment setting dialog box

Symptom There appears to be two or more focuses.
Details On Windows, when a dialog box is closed with the "Save&Reflect" button, it might seem

that there are two or more focuses from the time of next environment setting dialog box
starting.

Action None.

C.5 Copy and paste

Symptom Copying and pasting might not work with other applications.
Details When RC2000 is running and JRE1.3.1 is used, data copied by RC2000 may not be pasted

properly to other applications, or vice versa.
Action The Copy key and Paste key may work in Solaris OE.  There is no solution method for

either key not working in Solaris OE.
There is no solution method on Windows.

Symptom Two or more character strings sometimes seem to be selected.
Details In Solaris OE, while a character string is left selected in the common command input dialog

box after it has been copied, copying may be done on another application.  In this event,
the selected state in the common command input dialog box remains unreleased and
multiple character strings may seem to be selected.
When RC2000 is running and JRE1.3.1 is used, the copy & paste function used with other
applications is not guaranteed.
When RC2000 is running and JRE1.4.0 is used, the last character string copied in another
application is pasted.
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C.6 Key Input

Symptom There might be some invalid key.
Details The following virtual keys are not valid.

● XK_KP_F1 to XK_KP_F4
● XK_KP_Prior
● XK_KP_Next
● XK_KP_Begin
● XK_Begin
● XK_Prior
● XK_Next
● XK_F25 to XK_F35
● XK_Select
● XK_Print
● XK_Execute
● XK_Redo
● XK_Menu
● XK_Break

Action None.

C.7 Range of code conversion

The range of code conversion depends on the range of Unicode adopted by Java.

Also, the displayed characters depend on the fonts supported by the operating system.

This section explains the range in which Japanese-language EUC and PCK are not supported.

Codes in an unsupported range are indicated with a question mark (?).

C.7.1 Japanese EUC

The following code set is not supported on Solaris OE:

― Code set 1 -- 13 section -- special symbol

  0xada1 to 0xadfe

― Code set 1 -- 85-94 sections -- user-defined character

  0xf5a1 to 0xfefe

― Code set 3 -- 83 and 84 sections -- IBM extended Kanji

  0x8ff3f3 to 0x8ff4fe

― Code set 3 -- 85-94 sections -- user-defined character

  0x8ff5a0 to 0x8ffeff

The following code set is not supported on Windows:

― Code set 1 -- 13 section -- special symbol

  0xada1 to 0xadfe

― Code set 1 -- 85-94 sections -- user-defined character

  0xf5a1 to 0xfefe

― Code set 3

  0x8fa2a0 to 0x8ffeff

When RC2000 is running and JRE1.4.0 is used, the following code set is not supported either:

― Code set 1

0xa1bd
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C.7.2 PCK

The following code set is not supported on Solaris OE:

― Special symbol

0x8740 to 0x879f

― User-defined character

0xf040 to 0xf9fc

― IBM extended Kanji

0xfa40 to 0xfcfc

When RC2000 is running and JRE1.4.0 is used, the following code set is not supported either:

― Code set 1

0x815c

The following code set is not supported on Windows:

― User-defined character

0xf040 to 0xf9fc



Appendix D Troubleshooting

This appendix explains how to respond to problems that occur in RC2000.

D.1 Corrective action to a Problem

This section explains how to respond to problems that occur in RC2000.

Symptom 1:  RC2000 cannot be started

Corrective action1
For server/client operation, refer to “B.5 Messages from Web-Based Admin View," and respond

based on the displayed message.

Corrective action 2
For server/client operation, check the version of the plug-in to load into the Web browser.

The version required for starting RC2000 is 1.3.1 or later.  For further information, refer to the

RC2000 installation guide.  If an invalid version is used, refer to the Web-Based Admin View

Operation Guide, and specify settings so that a valid version is used.

Corrective action 3
For local operation, refer to “B.4.1 rclocal command messages,” and respond based on the

displayed message.

Corrective action 4
An option that is not a java command option may be specified in [java option] in the dialog box for

setting startup or the specification method may be incorrect.

Edit the contents of the java command options file to reflect the correct settings for the machine

for which startup is being set, then start RC2000.  For the correct startup settings, refer to

"3.6.2.2 java option."

Solaris OE:  /etc/opt/FJSVrcon/config/java_config

Windows:  <RC2000_installation_folder>¥java_config

Symptom 2:  Host information cannot be collected.

Corrective action
Refer to "B.2.1 Messages displayed in host browser," and respond based on the displayed

message.

Symptom 3:  Added host is not displayed when the RC2000 is started next time.

Corrective action
Saving of information may have failed when a host was added.
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Refer to "2.3 Addition of host," and add the host again.

Symptom 4:  Deleted host is displayed when the RC2000 is started next time.

Corrective action
Saving of information may have failed when a host was deleted.

Refer to "2.4 Deletion of host," and delete the host again.

Symptom 5:  Changed host is displayed with its registration name before the change

when the RC2000 is started next time.

Corrective action
Saving of information may have failed when a host was changed.

Refer to "3.4 Changing host," and change the host.

Symptom 6: A UNIX server, which has been added using the host addition function, is

connected to a destination or port that is different from the one originally registered with

RC2000 when RC2000 was restarted or the display was updated.

Corrective action
For operation with multiple clients, there are the following possibilities.

● Another client was started simultaneously, and it added a UNIX server with the same entry

name.

● Another client was started simultaneously, and it changed the entry name of a UNIX

server that was already registered with the same entry name.

● Another client deleted a UNIX server already registered, and added a UNIX server with

the same entry name but with a different connection destination or port.

Select [Change Host ...] from the [File] menu in the master control window to check the

connection destination or port that has been set.

Also, refer to “2.3 Addition of host,” and add a host again as necessary.  For this operation,

select [Refresh] from the [File] menu in the master control window to reflect the latest OS console

information of UNIX servers in the host browser display, and then add a host.

Symptom 7:  The UNIX server for the host group cannot be used.

Corrective action 1
For server/client operation, check the user who logged in to Web-Based Admin View.  To check

the login user of Web-Based Admin View, refer to the value indicated at “SUSER” in the window

displayed by following the instructions in “3.1.2.16 [Help]- Environment.”  A UNIX server

belonging to the "Host" group can be used only when the user logs in to Web-Based Admin View

as the system administrator.

Corrective action 2
For local operation, check the user who started RC2000.  To check the user who started
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RC2000, refer to the value indicated at “LUSER” in the window displayed by following the

instructions in “3.1.2.16 [Help]- Environment.”  The UNIX server can be used if a user who

started RC2000 has the authority to operate UNIX servers with permission for only read/write

operation.

● For information regarding users who can operate UNIX servers with permission for only

read/write operation, refer to “Access authority” in “1.3 Access to OS Consoles.” 

Symptom 8:  The host browser is displayed incorrectly.  Part or all of the host name is

displayed as "....", or the display area for one host is enlarged.

Corrective action
Execute [Redraw host browser] from the [File] menu in the master control window.

Symptom 9:  Connection to the host fails.

Corrective action
Refer to "B.2.2 Messages displayed in console window," and respond based on the displayed

message.

Symptom 10:  The console window is displayed incorrectly.

Corrective action 1
The number of lines may not have been set for the resized console window.

Refer to "3.2 Console window," and set the number of lines according to the information in the

notes.

Corrective action 2
If vi is used to open the file that stores characters not supported by Unicode, the columns after

the target characters may be displayed incorrectly.

While vi is displaying the contents of the file, enter Ctrl+L in vi command mode to redisplay the

window.

Corrective action 3
When a program using curses is executed, data may not be displayed properly depending on the

setting of the starting locale and code conversion mode.

Refer to “3.5.2.1 Code Converting Mode,” and set the code conversion mode corresponding to

the starting locale.

To check the starting locale, refer to the value indicated at “LANG” in the window displayed by

following instructions in “3.1.2.16 [Help]- Environment.”

Symptom 11:  Characters are displayed incorrectly in the console window.
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Corrective action
The fonts to be used in RC2000 are determined by the RC2000 starting locale.  Some fonts may

be displayed incorrectly.

Refer to "3.1.2.16 [Help]-Environment," check the "LANG" settings in the window to be displayed

and restart RC2000 as required in an appropriate locale.

"LANG" indicates the locale name specified when RC2000 is started.

Use one of the following methods to change the starting locale:

● Select a locale from the [Language] menu in the Solaris OE login window and log in to the

UNIX server.

● Use the Solaris OE terminal emulator to set the LANG environment variable, and start the

Web browser to display Web-Based Admin View from that terminal emulator.

● Use the appropriate OS in Windows.

Symptom 12:  The focus does not return to the console window.

Corrective action
If the focus is moved outside the console window, it may not return to the console window that

held it.

Click [Data input/output area] in the console window.

Symptom 13:  The data input-output area in the console window is highlighted when

the window is restored after being minimized.

Corrective action
If the minimized console window is double-clicked, the second click may be recognized after the

window is restored.

For this reason, the data input/output area in the console window may have been highlighted.

Single-click the minimized console window to restore the window.

Symptom 14:  The candidate window for Japanese-language conversion does not

disappear.

Corrective action
If the console window is minimized while the candidate window for Japanese-language

conversion is displayed, the candidate window may continue to be displayed.

Before minimizing the console window, close the candidate window.

Symptom 15:  Saved environment settings do not take effect when the RC2000 is

started next time.

Corrective action
Saving of information may have failed when the environment settings were saved.

Refer to "3.5 Environment setting/saving," and save the environment settings again.
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Symptom 16:  Settings in the environment setting dialog box differ from those used

the last time that RC2000 was started 

Corrective action
Settings in the environment setting dialog box may differ from those used previously if:

● A host was added with the same entry name as that of the UNIX server for which a host

had been deleted, or a host name was changed to the same entry name.

● A host was added with the same entry name as the original entry name of the UNIX server

for which a host had been changed, or a host name was changed to the same entry

name.

Refer to “3.5 Environment Setting/Saving,” and specify the applicable environment setting again

as necessary or save it.

Symptom 17:  The UNIX server is not put in OpenBoot mode even though a Break

signal is sent.

Corrective action 
Check whether the, mode switch on the UNIX server is set to ”lock” or "secure."

If ”lock” or "secure" is valid, the Break signal was ignored.

For changing the setting of the mode switch, refer to the user’s guide of main processing unit.

Symptom 18:  Buttons in the message dialog box have no effect.

Corrective action
If a dialog box is displayed over another displayed dialog box, some of the buttons in the

displayed dialog boxes may not respond.

Use the Escape key or the title bar in the top dialog box to close the problem dialog box.

Symptom 19:  The message in the message dialog box cannot be read completely. 

Corrective action
Enlarge the message dialog box so that all messages can be read.

Symptom 20:  The default button cannot be used in the environment setting dialog

box.

Corrective action 
If the focus is placed in the combo box (Code Converting Mode, Font Size) of the environment

setting dialog box, [Reflect] (default button) may not be executed even though the Enter key is

pressed.

Use the Tab key or mnemonic keys to move the focus outside the combo box, then press the

Enter key.
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Alternatively, click the [Reflect] button.

Symptom 21:  If the Escape key is pressed while a list is displayed in the combo box

of the environment setting dialog box, the dialog box is closed.

Corrective action
If the Escape key is pressed while a list is displayed in the combo box (Code Converting Mode,

Font Size) of the environment setting dialog box, the dialog box is closed, and environment

settings are not saved.

Use the mouse to clear the list that is displayed in the combo box.

Symptom 22:  Arrow keys ([ ] and [ ]) cannot be used to display the list in the

combo box of the environment setting dialog box.

Corrective action
The arrow keys may not be able to display the list in the combo box (Code Converting Mode, Font

Size) after they are used in the environment setting dialog box.

Use the mouse or Space key to display the list in the combo box.

Do not use the arrow keys in the environment setting dialog box.

Symptom 23:  Copying by double-clicking fails in [Command input area] in the shared

command input dialog box.

Corrective action
Copying by double-clicking may fail after Japanese-language characters have been entered in

[Command input area].

Use the mouse to drag the information to be copied.

Symptom 24:  IM status is displayed.

Corrective action
If ATOK is used as the Japanese-language input system in Solaris OE, the ATOK status may be

displayed even in non-Japanese-language input mode. This causes no problems, however.

Use a non-ATOK Japanese-language input system to clear the display.

Symptom 25:  RC2000 is disabled or ended without any notification.

Corrective action 1
Memory may be insufficient.

Check the memory installed on the system. RC2000 requires 256 megabytes for Solaris OE, and

128 megabytes for Windows.
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For information about the memory installed on the system, refer to the applicable installation

guides prepared for RC2000 component products.

Corrective action 2
Memory may be insufficient.

Quit unnecessary programs and restart RC2000.

Corrective action 3
If you attempt to allocate memory that exceeds the maximum memory size (initial setting value) of

64 megabytes for JavaVM, a memory shortage may occur, causing RC2000 operation to fail.

For example, such an error occurs when too many devices are connected to the host, the console

window is resized, or the number of scroll buffer lines is changed.

Use a Java command option that specifies the maximum size of memory used when eight or

more console windows are opened or the number of scroll buffer lines is increased.

Java command option can be specified by selecting [Set Starting...] from the [Settings] menu in

the master control window.

If the maximum size of memory that is to be used is 128 megabytes, for example, specify "-

Xmx128m."

Use the formula shown below to calculate the memory size to be specified:

The default value of the maximum memory size is 64 megabytes.  If calculated value exceeds

64, specify the option.

Maximum size of memory used = 2 + (Number of console windows + 1) * (Lines to be scrolled

/1000 * Number of columns/160 + 2)

Note:

Number of console windows is the number of console windows to be opened simultaneously.

Number of columns is the number of columns displayed when the console window is maximized.

Specify 160 when the font size is the default value.

Example:

● When 20 windows are opened and the number of scroll buffer lines is 5120 (default

value)

2 + (20 + 1) * (5120/1000 * 160/160 + 2) = 2 + 21 * 7.1 = 152

=>Use a Java command option to specify -Xmx152m.

● When eight windows are opened where the number of line of the scroll buffer is specified

as 32,767

2 + (8 + 1) * (32767/1000 * 160/160 + 2) = 2 + 9 * 34.8 = 315

=>Use a Java command option to specify -Xmx315m.

Note that it may not be possible to allocate the memory size specified in the Java command

option, depending on the system environment and the number of other programs started.

Corrective action 4
Check whether RC2000 is started more than once.

If RC2000 is started more than once on the same machine, a memory shortage may occur

(depending on the number of RC2000 windows opened, the number of console windows opened,

and the machine environment), causing RC2000 operation to fail.

If RC2000 is started more than once, close one of the instances.
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Corrective action 5
Check the Japanese-language input system that is being used.

ATOK8 may be the input system used.

If ATOK is used as the Japanese-language input system in Solaris OE and Windows, operation

cannot be guaranteed.

On Solaris OE, use a Japanese-character input system other than ATOK8.  On windows, use

MS-IME.

Corrective action 6
RC2000 may be started with the UTF-system specified for LANG in one of the following ways:

● The UTF-8 locale is selected from the [Language] menu in the Solaris OE login window to

log in to the UNIX server.

● The LANG environment variable is used to specify the UTF-8 locale on the Solaris OE

terminal emulator, and the Web browser that will display Web-Based Admin View is

started.

Use a non-UTF-8 locale.

Corrective action 7
Check the [Code Conversion Mode] setting in the environment setting dialog box.

If the UTF-8 locale is selected in [Code Conversion Mode], the console window may be unable to

function.

Select a non-UTF-8 locale.

Corrective action 8
Check for a exit operation by the terminal emulator that executed the rclocal command.  If the

terminal emulator is exit after RC2000 was started, RC2000 may be terminated.

Do not exit the terminal emulator that executed the rclocal command

D.2 Collecting Troubleshooting Information

If a problem occurs in RC2000, collect troubleshooting data and ask a Fujitsu engineer to

investigate.

How data is collected depends on the environment in which RC2000 operates.  Use the

following procedures to collect the data.

Solaris OE
1. Log in as a system administrator.

2. Execute the maintenance information collection command:

#/opt/FJSVsnap/bin/fjsnap <output_file_name>

Use <output_file_name> to specify the name of the file that will hold the information

collected as a result of executing the fjsnap command.  This parameter cannot be

omitted.

For the fjsnap command, refer to " README(/opt/FJSVsnap/README)."

3. For local operation mode, also collect files in the following directory:

- $HOME/.rc2000
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Windows
1. Compress the following folder:

- < RC2000_installation_folder >

For example, <RC2000_installation_folder> when RC2000 is installed in Program

Files¥RC2000 in WindowsME is as follows:

<OS_installation_drive>:¥windows¥Program Files¥RC2000

- <RC2000_information_folder>

<RC2000_ information_ folder> is <user_home_folder>¥.rc2000

For example, <RC2000_information_folder> for WindowsME is as follows:

<OS_ installation_drive>: ¥windows¥.rc2000.

<RC2000_information_folder> for Windows2000 is as follows:

<OS_installation_drive>:¥Documents and

Settings¥<system_logon_user_name>¥.rc2000

2. Make a hard copy.

Make a hard copy of the RC2000 window.

● If a problem occurs when starting from Web-Based Admin View, also collect Web-Based

Admin View troubleshooting data.

For more information about collecting Web-Based Admin View troubleshooting data, refer

to the Web-Based Admin View Operator's Guide.
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Glossary

Cluster system
System that connects multiple independent servers and operates them as a

single system. A cluster system features high reliability, high operability, and

scalability.

Combo box
List of items that can be selected.

Curses
Library for creating applications that support GUI-passed character input and

output.  Cursor position and text display position can be chosen freely

based on ESC sequences.

ESC sequence
Terminal control codes for changing display colors and character properties.

They have this name because they start with the control code 0x1b

(Escape).

Explorer
File management software supplied with Windows as a standard feature.

[Start]->[Programs]->[Explorer] open Explorer, which provides the user a

complete view of the PC while it is being used.  Windows operations such

as the transfer, copying, and deletion of files are based on this software.

Font property file
Java uses Unicode to handle character strings.  The font property file

(font.properties) is used to define virtual Unicode fonts and specify the

mapping of Java fonts and actual fonts that can be used on the host on

which Java runs.

Host information
Information such as the connection destinations and registration names for a

host that is displayed in an RC2000 host list.

Host name
Refers to the name that is recognized by the communicaiton network.

Internet Explorer
Refers to the Web browser manufactured by Microsoft Corporation.

IP address
Number (address) assigned to a network or host computer on the network.
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Java
Object-oriented programming language designed and developed by Sun

Microsystems, Inc. released in May 1995.  Java programs are compiled into

intermediate code that is executed on the Java virtual machine (JavaVM)

installed for an OS.

Java Plug-in
Refers to JavaVM for the Web browser manufactured by Sun Microsystems.

Java Virtual Machine (JavaVM)
A virtual computer that interprets and executes programs written in the Java

language. In the Java execution environment, Java virtual machine indicates

the part that interprets and executes Java byte code. The role of the Java

virtual machine is to mask inter-OS and interprocessor differences.

Java(TM)2 Runtime Environment (JRE)
Software set required in order to perform software developed in the Java

offered by Sun Microsystems.

Locale
Language environment that includes country settings such as the formats

used dates and time.

Netscape
Refers to the Web browser provided by Netscape Communications

Corporation.

Node
A single computer (on which a single operating system operates). A server in

a cluster system.

OpenBoot
Firmware that has the following three functions:  booting of the OS from

large-capacity storage devices or networks, interactive testing of hardware

and software, and provision of a command line interface for a system

console.  OpenBoot is stored on the system boot PROM and starts

operation as soon as the system is booted.

OS console
OS and Open Boot PROM consoles.

Partition
Hardware system that is separated logically by using a combination of

system boards in a PRIMEPOWER1000, etc.  Each partition can operate

independently.

PRIMECLUSTER
Software for cluster system construction provided by Fujitsu.
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PROM (Programmable Read-Only Memory)
Chip that includes information and firmware. PROM stores system host IDs,

and boot parameter configurations and settings for boot devices and for

other systems.

Public LAN
LAN used for business applications.

Remote Console Connection Unit
Device that converts the RS-232C interface to a LAN interface.  It is

installed on each node in a cluster system to obtain the OS console in the

LAN environment.

RC2000
Software that provides a function for operating the OS console of a UNIX

server (PRIMEPOWER, GP7000F).

System Console Software (SCS)
Software for installation and maintenance of the main unit provided by

Fujitsu.

Scroll buffer
Buffer that saves lines that disappeared from the top the console window.

Segment
A LAN, which is the minimum unit in a network

System clipboard
An area in the system for temporarily storing data.

System console
UNIX server for managing PRIMPOWER servers (model 800 and higher)

and GP7000Fservers (model 1000 and higher).

Telnet-Break 
Interrupt signal sent from a Telnet terminal to the host.  It is mainly used to

interrupt programs that are being executed.

UNIX server
In this manual, Solaris OE server such as PRIMEPOWER and GP7000F.

Web-Based Admin View
Common base for using GUI (operation management view) by

PRIMECLUSTER, System Console Software, etc.
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